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Version Information

Version Release Date Notes

1 Aug 2017 Initial release

2 Aug 2017 Added Luxul XMS 7048P switch

3 Aug 2017 Added static route information

4 Nov 2017 Added Luxul AMS 4424P switch

5 Jun 2018 Added Pakedge S3L-24P

6 Jul 2018 Added Cisco SG350 and SG550X switches

7 Aug 2018 Added Luminex GigaCore 26i

8 Sep 2018 Added Ruckus ICX 7150-48ZP

9 Nov 2018 Added IGMP and PoE budget requirements for switches used with OmniStream

10 Dec 2018 Added Ubiquiti ES-48-500W / 750W switch

11 Mar 2019 Luxul switches removed - not OmniStream certified; added Cisco SG350X-24MP

12 May 2019 Added Araknis Networks AN-310-SW-F/R-16-POE and F/R-24-POE

13 May 2019 Added Araknis Networks AN-310-SW-F/R-8-POE

14 Jun 2019 Added step-by-step instructions for manually configuring certified Cisco and
Araknis switches.

15 Jun 2019 Added Appendix/troubleshooting section

16 Jun 2019 Added Ubiquiti ES-24-500W / 250W switch

17 Jul 2019 Added Netgear M4300-28G-PoE+ / M4300-52G-PoE+ switches

18 Sep 2019 Added Cisco SG350X-48MP switch

19 Sep 2019 Added Extreme Networks X460-G2-24P-10GE4

20 Sep 2019 Added Aruba Networks 2930F-24G-PoE+-4SFP

21 Dec 2019 Re-added Luxul AMS-4424P based on firmware v4.1.3

22 Dec 2019 Added diagram explaining home static rouing. Refer to Home Router Static
Routing (page 7) for more information.

23 Apr 2021 Added configuration requirements for Cisco 9300-series switches.

24 Jun 2021 Added Cisco CBS350-24FP-4X (page 17) and the following Netgear switches:
- Netgear M4250-10G2F-PoE+ (page 37)
- Netgear M4250-26G4F-PoE+ (page 38)
- Netgear M4250-40G8F-PoE+ (page 39)
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Introduction

Switch Requirements

Atlona has made every effort to make sure that all switches listed in this document, meet or exceed functionality
with OmniStream products, identifying them as OmniStream Certified Switches. Atlona will continue to update this
document as more switches are tested. However, due to the vast number of manufacturers and switch models

on the market today, it is not possible to test each one. Before purchasing a switch that is not included in this
document, make sure that it supports the following features.

IGMP

e |GMP Snooping

e IGMP Querier

e |IGMP Immediate Leave

® Unregistered Multicast Flooding

e Static Multicast Groups (optional)

IMPORTANT: Failing to meet all of the above requirements (except for Static Multicast Groups) may
lead to performance issues.

PoE Budget

In addition to the above requirements, the power budget of the PoE switch must be identified. To determine the
maximum number of PoE devices that can be connected to a switch, two factors need to be considered:

1) The PoE budget of the switch.
2) The power requirements of each device.

When purchasing a switch, identify the PoE budget or power dedicated to PoE, in the switch specifications.

This number is the total power that the switch can provide when PoE devices are connected. For example, a 24-port
370-watt PoE switch can supply up to 15.4 W of power on all 24 ports. In this case, you can connect 24 OmniStream
units.

capabilities, then OmniStream units must be connected to the external power supply (Atlona part no.

o NOTE: If connecting OmniStream devices to a non-PoE switch or if using the analog audio
AT-PS-48083-C). The power supply is not included and sold separately.

OmniStream Certified Switches 5
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Introduction

Features of Configurations

e Connect OmniStream devices plug and play.

e Connect management ports to an external network, such as a home router.

NOTE: Devices that are connected to either OmniStream ports (VLAN 10) or management ports
(VLAN 1) on the OmniStream switch will be able to communicate with both the OmniStream units as

o well as the Internet (using a connected home router). Devices that are connected to the home router
will only be able to connect to OmniStream devices if a static route is configured on the home router.
Refer to Home Router Static Routing (page 7) on the next page.

Home Router

Encoder

Switch

Encoder

Legend

VLAN 10
VLAN 1

Decoder Decoder

Known Limitations

e The network configuration file is applicable only to one standalone switch.
e If planning to connect multiple switches together, then a custom configuration will be required.

e Management network must use IP addresses from 192.168.1.1 through 192.168.1.253. If a different range is
used, then a custom configuration will be needed.

e The management ports have DHCP disabled, as a typical home router will handle this task. If the system will not
be connected to another network using the management ports, one of the OmniStream ports should be used for
management.

e Without a static route configured on the home router, any devices connected to the home router will not be able
to connect to the OmniStream devices.

e The home router must be set to 192.168.1.x in order for the Internet to be accessible from the OmniStream VLAN
(VLAN 10).

OmniStream Certified Switches 6
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Introduction

Home Router Static Routing

In order for devices that are connected to the home router, to be able to connect to OmniStream devices on VLAN
10, a static route must be configured on the home router. This static route is required to send the network traffic to
the proper destination. Configuring static routing will vary by manufacturer, but most home routers have this ability.
Essentially, the router must be instructed to route any traffic bound for the 10.1.0.0/23 range (IP address starting at
10.1.0.0 with a subnet mask of 255.255.254.0) will use the gateway 192.168.1.254. However, if the home router is
using the same gateway, then the IP address of the switch must be changed to 192.168.1.253.

NOTE: Without defining a static route on the home router, the system will still function properly but
without connectivity to the OmniStream devices (VLAN 10) from the home router.

A static route for the OmniStream ports (VLAN 10) would be defined assuming that the home router is set to
192.168.1.1. If this is not the case, then the static route will need to be modified to enable Internet access to the
OmniStream VLAN.

NOTE: If the home router is not set to 192.168.1.1, then the configuration file may still be used as is,
but VLAN 10 will not have Internet access.

The diagram below shows a sample home network setup using a Cisco SG300-24MP switch. In this example,
devices on the home network (VLAN1) can be connected to ports 25 through 28. The router (with a static IP
address), for example, can be connected to port 25, allowing three additional devices to be physically connected to
ports 26 through 28. Ports 1 through 24 (VLAN10) would be used to connect OmniStream devices. Note that the
switch has two IP addresses, allowing the laptop on VLAN1 to access OmniStream devices on VLAN10. Except for
the switch and the router, all other IP addresses are arbitrary.

192.168.1.1

E Home Router

192.168.1.254 /10.1.1.254

Laptop
192.168.1.3

Encoder

Switch 10.1.0.112

Encoder
10.1.0.28

Legend

VLAN 10:

Switch IP Address: 10.1.1.254 (IGMP Querier)
DHCP range: 10.1.0.1 - 10.1.0.255, inclusive
Useable Physical Ports: 1 - 24, inclusive

Decoder Decoder
10.1.0.51 10.1.0.125

VLAN 1

Switch IP Address: 192.168.1.254
Router IP address: 192.168.1.1 (static)
Useable Physical Ports: 25 - 28, inclusive

OmniStream Certified Switches 7
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Default Configurations

Araknis Networks AN-310-SW-F/R-8-POE

Configuration File

https://atlonainc.box.com/s/y81xwh9cevb6m4fn94589qgjvphu18bqu5

Summary

Version: 1.2.00

Ports 1 through 8 can be used to connect OmniStream devices.

Configuration Details

VLANT:

Once the configuration file has been uploaded, access the switch GUI using the following IP address:
http://10.1.1.254

e Hostname:

e Login credentials

*

Username:

*  Password:

e VLAN1

*

Ports:

*

Default gateway:

DemoSw

admin

Atlona

1 through 10
10.1.1.1

will need to be provided. In this case, a router with DHCP pool enabled can be connected to any

o NOTE: Araknis L2 switches do not provide an integrated DHCP service. A separate DHCP server

physical port on the switch.

e Spanning tree mode:

e IGMP

Snooping:

*

*

Querier:

Immediate leave:

RSTP

Enabled
Enabled
Enabled

OmniStream Certified Switches 8
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Default Configurations

Araknis Networks AN-310-SW-F/R-16-POE

Configuration File https://atlonainc.app.box.com/s/s4rhypkgyjacbmgh3tczl7auxz7g8mpm

Summary
Version: 1.2.00

Ports 1 through 16 can be used to connect OmniStream devices.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:
VLANT: http://10.1.1.254

e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 1 through 18
*  Default gateway: 10.1.1.1

will need to be provided. In this case, a router with DHCP pool enabled can be connected to any

o NOTE: Araknis L2 switches do not provide an integrated DHCP service. A separate DHCP server
physical port on the switch.

e Spanning tree mode: RSTP
e IGMP
* Snooping: Enabled
*  Immediate leave: Enabled
* Querier: Enabled

OmniStream Certified Switches 9
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Default Configurations

Araknis Networks AN-310-SW-F/R-24-POE

Configuration File https://atlonainc.app.box.com/s/vrerlra60k0z868irgf2blign42nf6n8

Summary
Version: 1.2.00

Ports 1 through 24 can be used to connect OmniStream devices.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:
VLANT: http://10.1.1.254

e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 1 through 26
*  Default gateway: 10.1.1.1

will need to be provided. In this case, a router with DHCP pool enabled can be connected to any

o NOTE: Araknis L2 switches do not provide an integrated DHCP service. A separate DHCP server
physical port on the switch.

e Spanning tree mode: RSTP
e IGMP
* Snooping: Enabled
*  Immediate leave: Enabled
* Querier: Enabled

OmniStream Certified Switches
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Default Configurations

Uploading configuration files to Araknis switches

Download the required configuration file.

Open a web browser and enter the IP address of the switch in the address bar: 192.168.20.254

Enter the login credentials to access the user interface. The default credentials are listed below:

Username:
Password:

araknis
araknis

Click MAINTENANCE > FILE MANAGEMENT.

‘araknis

@ sTatus
SYSTEM
PORTS
@ setrines
SYSTEM
PORTS
POE
VLANS
LINK AGGREGATION
ACCESS MANAGEMENT
PING TEST
TRACE ROUTE

+FILE MANAGEMENT
RESTART DEVICE
LOG OUT

@ ADvANCED

FILE MANAGEMENT

Configuration File

4 CLOUD SERVICE: Mo

System Time:

|n.d-pc-_mum

-

Upload New Configuration File

Choose File | Mo file chosen

| Restore Factory Defauits

Firmware &

| Gurrent Firmueare Version

Partition

Upload New Firmware

| Status | Image Nams

[ Image Size(Byte)

. Fartiticn O

| Actve IMG-1.2.00

Created Time |

GOBE54G

HNTA225 161953

| a Fartition 1

| Backup | mMG-1200

20171225 161953 |

[ ] o

System Uptime: 1d 0454 1

downloaded in Step 1.

5. Under the Configuration File section, click the Choose File button and select the configuration file which was

‘araknis N T " R
Choose File button
& sTatus
A Configuration File
PORTS
() seTTINGS £ |
SYSTEM Choose Ko Configuration cfg
Upload New Configuration File
PORTS
POE
Rosareracoryoemus [ |
LINK AGGREGATION
ACCESS MANAGEMENT Bi re &
|cr e Versio F“m |
PING TEST
TRACE ROUTE Partition I Partition O{Active) -
s : | Ghoose File | file chosan
RESTART DEVICE Upload New Firmware .
LOG OUT
() ADVANCED
Dual Image
LG Search ) [ Active Flash Partition | status | Image Name [ image Size(Byte) | Created Time |
Partition 0 | Active 1MG-1.2.00 GO8B545 | 2017.12.25 1618 53
| : Partition 1 Backup IMG-1200 [ soessas 2017-12.25 161953 |
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6. Click the From PC button to begin uploading the configuration file to the switch.

‘Graknis e i
o
@ sTaTUS From PC button
A Configuration File
PORTS
(D seETTINGS
| Configuration cfg
] Upload New Configuration File
PORTS
POE |a F Dt [ |
VLANS
LINK AGGREGATION
ACCESS MANAGEMENT Bl re &
|c,. Pl Versio t“m |
PING TEST
TRACE ROUTE Partition I Partition (fActive)
i : | Ghoose Fila | No file chosen
RESTART DEVICE Upload New Firmware
LoG 6UT p Partition
() ADVANCED
Dual Image
[ Q) Search ) [ Active Flash Partition [ status | Image Name [ Image Size(Byte) | Created Time |
- Partition 0 | ctive IMG-1.2.00 GOBE54E | 2017.92.25 161953
| - Parition 1 Backup | IMG-12.00 [ soasses 20171225 1619.53 |

7. A Confirmation message box will be displayed. Click OK to dismiss the message box and continue with the
upload procedure.

Confirmation

Dunics will reestart after config restore fnishad

8. Enter the new IP address of the switch in a web browser window: 10.1.1.254.

9. Configuration is complete. Log in to the switch using the following credentials:

username: admin
password: Atlona

OmniStream Certified Switches
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Aruba Networks 2930F-24G-PoE+-4SFP (JL261A)

Configuration File https://atlonainc.box.com/s/u9e7ivw3mmd8rvziaaffim40bs58kre

Summary
Version: WC.16.05.0013
Ports 1 through 23 are to be used only for OmniStream.

Ports 24 through 28 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports: 24 through 28
*  Default gateway: 192.168.1.1 (home router for Internet traffic)

A IMPORTANT: Ports 25 - 28 are SFP interfaces and intended for 1G transceivers.

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected
to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used,
then the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 23
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e [GMP (VLAN 10 only)

e Spanning tree mode: RPVST *  Snooping: Enabled
e BPDU guard: Enabled *  Unregistered flooding: Disabled
e Loop protection: Enabled *  Immediate leave: Enabled
e SSH: Enabled * Querier: Enabled

OmniStream Certified Switches
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IGMP Filtering

The following table lists IP addresses which are excluded from IGMP filtering, and should not be used.

Groups of consecutive addresses in the range of Groups of consecutive addresses in the range of

224.0.0.x to 239.0.0.x 224.128.0.x t0 239.128.0.x
224.0.0.x 232.0.0.x 224.128.0.x 232.128.0.x
225.0.0.x 233.0.0.x 225.128.0.x 233.128.0.x
226.0.0.x 234.0.0.x 226.128.0.x 234.128.0.x
227.0.0.x 235.0.0.x 227.128.0.x 235.128.0.x
228.0.0.x 236.0.0.x 228.128.0.x 236.128.0.x
229.0.0.x 237.0.0.x 229.128.0.x 237.128.0.x
230.0.0.x 238.0.0.x 230.128.0.x 238.128.0.x
231.0.0.x 239.0.0.x 231.128.0.x 239.128.0.x

Instructions for uploading the configuration file for Aruba switches

1. Download the required configuration file.

2. Connect a PC to the console port of the Aruba 2930F, using a rollover cable (not provided with switch). If the PC
only has USB ports, a DB9-to-USB serial adapter will be required.

3. Open a terminal session on the PC. The Aruba switch will auto-detect the baud rate and the switch will be
placed in privileged mode, which is idenfied by the “#” prompt. Switch to global config mode by typing the
following at the command prompt, then press [ENTER]: config t

4. Type the following at the global config mode prompt and press [ENTER]: vlan 1

5. Enter an IP address and subnet mask for the switch, allowing access to the web interface, then press [ENTER]:
ip address 10.1.1.254 255.255.254.0

Refer to the illustration below for reference:

1 COM3 - Tera Term VT — O *

File Edit 5etup Control Window Help
Aruba-2930F-24C-PoEP-48FP#
Aruba-2930F-24C-PoEP-48FP#
Aruba-2930F-24C-PoEP-48FP#
Aruba-2930F-24C-PoEP-48FP#
Aruba-2930F-24C-PoEP-48FP#
Aruba-2930F-24C-PoEP-48FP#show running-config

Running configuration:

; JL261A Configuration Editor; Created on release #WC.16.05.0013
; Ver #14:01.30.08.1d.9b.3f.bf.bb.ef.7c.59.fc.6b.fb.9f.fc.ff.ff.37.ef:8d
hostname “Arubna-2930F-24G-PoEP-4SFP”
module 1 type jll26a
snamp-server community “public” unrestricted
vlan 1
name “DEFAULT VLAN”
untagged 1-28
ip address dhcp-bootp
exit

Aruba-2930F-24C-PoEP-48FP#iconf t

Aruba-2930F-24C-PoEP-48FP (config) #vlan 1

Aruba-2930F-24C-PoEP-48FP# (vlan-1)ip address 10.1.1.254 255.255.254.0
A 8F P4
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6. Connect the PC to any Ethernet port on the switch, from

You can get IP settings assigned automatically if your network supports
1 through 23. this capability. Otherwise, you need to ask your network administrator

for the appropriate IP settings.

7. Assign the PC Network Interface Controller (NIC) to
an IP address within the range of 10.1.0.0/23. For (O Obtain an IP address automatically
example: 10.1.1.200 255.255.254.0. Inthe (®) Use the following IP address:
Default gateway field, enter 10.1.1.254. Refer to the IP address: [10.1 .1 .20
illustration on the right. Subnet mask: [255.255. 0 . 0
Default gateway: I 0. 1. 1,25
Obtain DNS server address automatically

(®) Use the following DNS server addresses:

Preferred DNS server: I

Alternate DNS server: [

D validate settings upon exit Advanced...

8. Open a web browser and enter the gateway IP address of 10.1.1.254.

9. Log in to the switch web interface and enter the following credentials, if required:

user: admin
password: (leave blank)

10. Click Configuration > Management and load the Atlona provide Aruba switch configuration.

10.1.1.254 (Demosw) CHNORRICOI WO MY
configl h Latest Events Al 1000
@ info
Auth
Update
@ Select configuration file to update or upload a new file:
@ info
Ports
@ info

Ports
Aruba 2930F 24G PoE+ 4SFP+ Configuration for Atlona Omnistream.pcc - 2.67 KB

Browse
@ info

Ports

Ports

Select switch configuration file to update:

*Upload New File* v
Event Breakdown (past 24 hours)

OmniStream Certified Switches
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11. Under the Update section, locate the Select switch configuration file to update: drop-down list and select
config1 to overwrite this configuration file. By default, this is the start-up configuration filename.

10.1.1.254 (Demosw) Search Q O e LE L @

configl v Latest Events Al 1000

® info
Auth
Update
@ Select configuration file to update or upload a new file:
® info
Ports

® info

Ports
Aruba 2930F 24G PoE+ 4SFP+ Configuration for Atlona Omnistream.pcc - 2.67 KB

Browse
® info

Ports

Select “config1”

Ports

Select switch cogffguration file to update:

Event Breakdown (past 24 hours)

12. Click Yes when prompted to overwrite the configuration file.

Are you sure you want to update/upload a
configuration file?

You will be uploading Aruba 2930F 24G PoE+ 4SFP+ Configuration for
Atlona Omnistream.pcc to replace config1.
Once you click yes, then you cannot cancel.

13. Switch configuration is complete and will take effect immediately, without the need for a reboot.

OmniStream Certified Switches
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Cisco CBS350-24FP-4X

Configuration File https://atlonainc.box.com/s/9n50aisim3pl31s1iklk8espsI80ks8y

Summary
Version: 3.1.0.57
GigabitEthernet ports 1 through 24 are to be used only for OmniStream.

TenGigabitEthernet ports 1 and 4 are to be used for management and can be connected to another network, such as
a router that has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

¢ Hostname: DemoSw

e Login credentials

*  Username: user configured
*  Password: user configured
e VLAN 1
*  Ports: TenGigabitEthernet 1 through 4
*  Static routing: 192.168.1.254 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN 10
*  Ports: GigabitEthernet 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e [GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled
e BPDU guard: Enabled *  Unregistered flooding: Disabled
e Green Ethernet: Disabled *  Immediate leave: Enabled
e Loop protection: Enabled * Querier: Enabled

*  Custom multicast address for AT-OMNI-232
management added

OmniStream Certified Switches 17
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Uploading configuration files to the Cisco CBS350-24FP-4X switch

1. Connect a computer directly to the Gi1/0/1 interface of the switch.

2. In Windows, go to the command prompt, type ncpa.cpl, and press [ENTER]. This will display the network
properties for Windows.

3. Right-click on the adapter for the network switch and select Properties from the context menu.

4. Under the Ethernet Properties dialog box, click Internet Protocol Version 4 and then click the Properties
button.

5. Click the Use the following IP address radio button and enter an IP address in the 192.168.1.0/24 subnet.
NOTE: Cisco CBS-series switches ship with a default IP address of 192.168.1.254/24.

6. Set the Subnet mask field to 255.255.255.0.
7. Click the OK button.
8. Download the configuration file from the link at the top of the page under Cisco CBS350-24FP-4X (page 17).

9. Open a web browser and enter the IP address of 192.168.1.254 to display the switch login screen.

# User Name: (0/20 characters used)

Password: (0/64 characters used)

Confirm Password:

Password Strength Meter: [l | Below Minimum

10. Log in using the default credentials:

Username: cisco
Password: cisco

11. When prompted, change the default password. If successful, the Getting Started page will be displayed.

Getting Started

This pae pfovides aasy SHpS 1o confguin your deico

£ Initial Setup * Quick Access

Srack

Administration
Port Management

il Device Status

Smanport
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Default Configurations

12. Click Administration > File Management > File Operations.

13. Click the Startup Configuration radio button.

File Operations

Operation Type: (*) Update File
() Backup File
() Duplicate

Destination File Type: O Running Configuration
(N Startup Configuration
t}ﬁirmr Configuration

Logging File
(O Language File
Dashboard Info File

Copy Method: ® HTTP/HTTPS H
T -
O UsSB

() Internal Flash

& File Name: | Choose File | No file chosen

14. Click Choose File and select the configuration file, downloaded in Step 6.

15. Click the Apply button.

English ~ | | Basic - 9 0 (=

Cancel

16. Once the upload procedure has completed, click Administration > Reboot.

Rustors fo Factory Cofaults

Clonr Stanup Confguraton Flo
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Default Configurations

17. Return to the Internet Protocol Version 4 (TCP/IPv4) Properties window on the computer.

18. Click the Obtain an IP address automatically radio button.

Internet Protocel Version 4 (TCP/IPvE) Properties x

Ganeral  Alternate Configuration
You can get IF settings assigned automaticaly if your network suppaorts

this capabdity. Othersisa, you nead to ask your network admirestrator
for the appropriate [P settings.

() Obtan an [P address automatically
{C) Use the following [P address:

[ ]
() Obtain DNS server address automatically
() Use the folowing DNS server addresses:

Valdate settings upon axit Advanced. .,

[oc ]1 come

19. Launch a web browser and go to 10.1.1.254.
20. Log in to the switch.

21. Configuration is complete.
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Default Configurations

Cisco SG300-10MPP

Configuration File https://atlonainc.box.com/s/zx00979vgcd2t4lelxe6Iin82k7 mvgizt

Summary
Version: 1.4.7.6
Ports 1 through 8 are to be used only for OmniStream.

Ports 9 and 10 are to be used for management and can be connected to another network, such as a router that has
Internet access.

The System Mode can be changed under Administration > System Settings > System Mode.

o NOTE: Before uploading the configuration, change the System Mode to L3 (router mode).
Refer to the image under Cisco SG300-52MP (page 23) for more information.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 9 and 10
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 8
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e [GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled * Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG300-28MP

Configuration File https://atlonainc.box.com/s/I0g7wxtnrckgr4cinl9k843yadmenolh

Summary
Version: 1.4.7.6
Ports 1 through 24 are to be used only for OmniStream.

Ports 25 through 28 are to be used for management and can be connected to another network, such as a router that
has Internet access.

The System Mode can be changed under Administration > System Settings > System Mode.

o NOTE: Before uploading the configuration, change the System Mode to L3 (router mode).
Refer to the image under Cisco SG300-52MP (page 23) for more information.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

¢ Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 25 through 28
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled *  Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG300-52MP

Configuration File

https://atlonainc.box.com/s/3ty9h2a2ni21csw2boa2tc0st9dxawao

Summary

Version: 1.4.7.6

Ports 1 through 48 are to be used only for OmniStream.

Ports 49 through 52 are to be used for management and can be connected to another network, such as a router that

has Internet access.

NOTE: Before uploading the configuration, change the System Mode to L3 (router mode).
The System Mode can be changed under Administration > System Settings > System Mode.

Getting Started
+ Status and Statistics

System Settings

System Summary
Interface
Etherlike

GVRP

802.1x EAP

ACL

TCAM Utilization
Health

» Management Interface

User Accounts
Idle Session Timeout
» Time Settings
» System Log
» File Management
Reboot
» Diagnostics
Discovery - Bonjour
» Discovery - LLDP
» Discovery - CDP
Ping
Traceroute

» Port Management

» Smartport

» VLAN Management

» Spanning Tree

4 3

System Settings
System Description
System Location:
System Contact:

“ Host Name:

(®) User Defined |Dem03y_d

SG300-52P 52-Port Gigabit PoE Managed Switch
(0/160 characters used)
(0/160 characters used)

) Use Default

System Mode

L2
® L3

Login Banner.

Preview...

Welcome Banner:

Custom Banner Settings

(0/1000 characters used)

(0/1000 characters used)

(6/58 characters used; Default: switch4d573d)

T

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:

VLANT1: http://192.168.1.254
VLAN10: http://10.1.1.254.
e Hostname: DemoSw
* Login credentials

*  Username: admin

*  Password: Atlona

OmniStream Certified Switches
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Default Configurations

e VLAN 1
*  Ports: 49 through 52
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 48
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days
e Spanning tree mode: RSTP
e BPDU guard: Enabled
e Green Ethernet: Disabled
e Loop protection: Enabled
e SSH: Enabled
e |[GMP (VLAN 10 only)
*  Snooping: Enabled
*  Unregistered flooding: Disabled
*  Immediate leave: Enabled
* Querier: Enabled

*  Custom multicast address for AT-OMNI-232 management added
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Default Configurations

Cisco SG350-10MP

Configuration File https://atlonainc.app.box.com/s/rankeecnh9ey21gtrxrogkafvda2i6r8

Summary
Version: 2.2.8.4
Ports 1 through 8 are to be used only for OmniStream.

Ports 9 and 10 are to be used for management and can be connected to another network, such as a router that has
Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

¢ Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 9 and 10
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 8
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled *  Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG350-28MP

Configuration File https://atlonainc.app.box.com/s/zt893yn66ifiIngctwcfsx2sc2z6rvpbh

Summary
Version: 2.2.8.4
Ports 1 through 24 are to be used only for OmniStream.

Ports 25 through 28 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports: 25 through 28
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled *  Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG350-52MP

Configuration File https://atlonainc.app.box.com/s/mri18ycd1we66g5v4m2ulidpjms1gqvzf

Summary
Version: 2.2.8.4
Ports 1 through 48 are to be used only for OmniStream.

Ports 49 through 52 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

¢ Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 49 through 52
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 48
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled *  Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG350X-24MP

Configuration File https://atlonainc.box.com/s/ovcb2ozkekvec713hyi7sn5n5lpyvagb

Summary
Version: 2.4.0.91
Ports 1 through 24 (Gigabit) are to be used only for OmniStream.

Ports 1 through 4 (Ten Gigabit) are to be used for management and can be connected to another network, such as a
router that has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports (Ten Gigabit): 1 through 4
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN 10
*  Ports (Gigabit): 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e [GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled * Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added

OmniStream Certified Switches 28



https://atlonainc.box.com/s/ovcb2ozkekvcc713hyi7sn5n5lpyvagb

a PaNpuIT company

Default Configurations

Cisco SG350X-48MP

Configuration File https://atlonainc.app.box.com/s/gg8zwwi76g3nc83hxsa607havyf7g8si

Summary
Version: 2.4.0.91
Ports 1 through 48 (Gigabit) are to be used only for OmniStream.

Ports 1 through 4 (Ten Gigabit) are to be used for management and can be connected to another network, such as a
router that has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports (Ten Gigabit): 1 through 4
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN 10
*  Ports (Gigabit): 1 through 48
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e [GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled * Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG550X-24MP

Configuration File https://atlonainc.app.box.com/s/w2ux7ckmvdiezsdk962nv49bxsk2sswu

o NOTE: The same configuration can be used for the Cisco SG550X-24MPP.

Summary
Version: 2.3.5.63
Ports 1 through 24 (Gigabit) are to be used only for OmniStream.

Ports 1 through 4 (Ten Gigabit) are to be used for management and can be connected to another network, such as a
router that has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports (Ten Gigabit): 1 through 4
*  Static routing (Ten Gigabit): 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports (Gigabit): 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled *  Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Cisco SG550X-48MP

Configuration File https://atlonainc.app.box.com/s/047er6etart69hxogl95c5rizkdnp3sx

Summary
Version: 2.3.5.63
Ports 1 through 48 (Gigabit) are to be used only for OmniStream.

Ports 1 through 4 (Ten Gigabit) are to be used for management and can be connected to another network, such as a
router that has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLAN1: http://192.168.1.254
VLAN10: http://10.1.1.254.

¢ Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports (Ten Gigabit): 1 through 4
*  Static routing (Gigabit): 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN 10
*  Ports (Gigabit): 1 through 48
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered flooding: Disabled

e Green Ethernet: Disabled *  Immediate leave: Enabled

e Loop protection: Enabled *  Querier: Enabled

e SSH: Enabled *  Custom multicast address for AT-OMNI-232

management added
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Default Configurations

Extreme Networks X460-G2-24P-10GE4

Configuration File https://atlonainc.box.com/s/n1jt42gu8njmhx705It2tclb61kknfkm

Summary
Version: 22.6.1.4
Ports 1 through 24 are to be used only for OmniStream.

Ports 25 through 32 are to be used for management and can be connected to another network, such as a router that
has Internet access. Refer to the technical specifications of the switch for usage.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 25 through 32
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 3 hours e |IGMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Unregistered Flooding: Disabled

e SSH: Enabled *  Immediate leave: Enabled
* Querier: Enabled
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Default Configurations

Luminex GigaCore 26i

Configuration File https://atlonainc.box.com/s/ggdm9ulolk7mr4oxr6e28mc7xov9seed

Summary
Version: 2.6.1

Ports 1 through 26 are to be used only for OmniStream.

Configuration Details

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 1 through 26
*  Static routing: 192.168.1.1

NOTE: The Luminex GigaCore26i switch cannot act as a DHCP server. For installations that require
DHCP, connect an external DHCP server to the switch. The Luminex GigaCore26i switch is a L2

o switch and can accommodate multiple L2 VLANs or networks, but cannot route between those
networks. In order to route traffic between multiple VLANSs, a user has to connect a router that will
handle the routing between multiple networks.

e VLAN 1
*  Ports: 1 through 26
*  DHCP range: N/A
e DHCP lease time: N/A
e Spanning tree mode: RSTP
e BPDU guard: Enabled
e Green Ethernet: Disabled
e Loop Protection: Enabled
e SSH: Enabled
e [IGMP
*  Snooping: Enabled
*  Unregistered flooding: Disabled
*  Immediate leave: Enabled
* Querier: Enabled
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Default Configurations

Uploading configuration files to the Luminex GigaCore 26i switch
o NOTE: The default IP address of the switch is 192.168.13.53 (255.255.0.0).

1. Download the Luminex GigaCore 26i configuration file from the link under Luminex GigaCore 26i (page 33).
2. Open a web browser and enter the IP address of the switch in the address bar.

3. Enter the login credentials. The following are the default login credentials:

Username: admin
Password: (no password)

4. Click Profiles in the side menu bar to access the Profile Manager.

Luminex

Port status IP Settings
Port d ) up ) DHCP
IP Addi

Profile Manager

e CECOCOECEECECEERCOCOECES

5. In the Profile Manager window group, click the Import button and select the Luminex GigaCore 261
Configuration for Atlona OmniStream.txt file.

Profile Manager
I

RLinkX (empty) (empty) (empty) fempty) (empty) (empty) (empty) (empty) (empty)

PoE

I Profiles

Save | Import

L3
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Once the file has been uploaded, a message box will be displayed indicating that the import procedure was
successful. Click the “X” in the upper-right corner of the message box to dismiss it.

Recall Profile x

Profile import successful.

6. Click the Recall button. The Recall Profile dialog box will be displayed. Click Recall all, as shown on the next
page.

Profile Manager - Active Profile: Atlona

(empty) (empty) (empty) (empty) (empty) (empty) (empty) (empty) (empty)

Po

I Profiles
network settings.

s B Recallall | No Network Settings

¥ stallation

NOTE: After the Recall all button is clicked, the switch will reboot and load the Atlona configuration
o file. The IP address of the switch will change from 192.168.13.53 (255.255.0.0) to 192.168.1.254
(255.255.255.0).

7. Change the IP address of the laptop to match the IP address range of the switch.

8. Log in to the switch with the following credentials:

Username: admin
Password: Atlona

NOTE: This configuration is based on VLAN 1. If a user requires configuration for a specific VLAN,
then it will need to be a custom configuration.

OmniStream Certified Switches 35




a PaNpuIT company

Default Configurations

Luxul AMS-4424P

Configuration File https://atlonainc.box.com/s/ihgkpbra26sds32rr6nj4atizkpsyhry

Summary
Version: 4.1.3
Ports 1 through 22 are to be used only for OmniStream.

Ports 23 and 26 are to be used for management and can be connected to another network, such as a router that has
Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:

VLANT: http://192.168.1.254
VLAN 10: http://10.1.1.254
e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports: 23 through 26
*  Static routing: 192.168.1.1 (home router for Internet traffic)

A IMPORTANT: Ports 25 and 26 are SFP+ interfaces and intended for 1G/10G transceivers.

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 22
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |IGMP

e Spanning tree mode: RSTP *  Snooping: Enabled
e BPDU guard: Enabled *  Unregistered flooding: Disabled
e Green Ethernet: Disabled *  Immediate leave: Enabled
e Loop Protection: Enabled * Querier: Enabled
e SSH: Enabled
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Netgear M4250-10G2F-PoE+

e M4250-10G2XF-PoE+ (GSM4212PX)

o NOTE: The following configuration will also work on the following switch models:
e M4250-10G2XF-PoE++ (GSM4212UX)

Configuration File https://atlonainc.app.box.com/s/i6e6d3he65f7exuzd4ixpas9blvh4xb3

Summary
Version: 13.0.2.21
Ports 1 through 10 can be used to connect OmniStream devices.

Ports 11 through 12 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:

VLAN1: http://192.168.1.254
VLAN 10: http://10.1.1.254
e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: user configured
e VLAN1
*  Ports: 11 through 12
*  Static routing: 192.168.1.254 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 10
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled
e BPDU guard: Enabled *  Immediate leave: Enabled
e Loop protection: Enabled *  Querier: Enabled
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Netgear M4250-26G4F-PoE+

e M4250-26G4F-PoE++ (GSM4230UP)

o NOTE: The following configuration will also work on the following switch models:
o M4250-26G4XF-PoE+ (GSM4230PX)

Configuration File https://atlonainc.app.box.com/s/9veozfcdvv46r9wgpgo75yxyokb4k3ib

Summary
Version: 13.0.2.21
Ports 1 through 26 can be used to connect OmniStream devices.

Ports 27 through 30 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:
VLANT1: http://192.168.1.254
VLAN 10: http://10.1.1.254

e Hostname: DemoSw
e Login credentials

*  Username: admin
*  Password: user configured
e VLAN1
*  Ports: 27 through 30
*  Static routing: 192.168.1.254 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 26
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled
e BPDU guard: Enabled *  Immediate leave: Enabled
e Loop protection: Enabled *  Querier: Enabled
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Netgear M4250-40G8F-PoE+

* M4250-40G8XF-PoE+ (GSM4248PX)

o NOTE: The following configuration will also work on the following switch models:
e M4250-40G8XF-PoE++ (GSM4248UX)

Configuration File https://atlonainc.app.box.com/s/2pg4rkblbxk45kadkfuz0sv4hs43pxnl

Summary
Version: 13.0.2.21
Ports 1 through 40 can be used to connect OmniStream devices.

Ports 41 through 48 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:
VLANT1: http://192.168.1.254
VLAN 10: http://10.1.1.254

e Hostname: DemoSw
e Login credentials

*  Username: admin
*  Password: user configured
e VLAN1
*  Ports: 41 through 48
*  Static routing: 192.168.1.254 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 40
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled
e BPDU guard: Enabled *  Immediate leave: Enabled
e Loop protection: Enabled *  Querier: Enabled

OmniStream Certified Switches 39



https://atlonainc.app.box.com/s/2pg4rkblbxk45ka4kfuz0sv4hs43pxnl

a PaNpuIT company

Default Configurations

Uploading configuration files to Netgear 4250 switches

1. Connect a computer directly to the switch using the out-of-band (OOB) interface.

2. In Windows, go to the command prompt, type ncpa.cpl, and press [ENTER]. This will display the network
properties for Windows.

3. Right-click on the adapter for the network switch and select Properties from the context menu.

4. Under the Ethernet Properties dialog box, click Internet Protocol Version 4 and then click the Properties
button.

5. Click the Use the following IP address radio button and enter 192.168.0.100 in the IP address field.
6. Set the Subnet mask field to 255.255.255.0.

7. Click the OK button, then minimize the Network Connections window. This window will be used again, later in
the procedure.

8. Download the configuration file from the link at the top of the page under Netgear M4250-10G2F-PoE+ (page
37) or Netgear M4250-40G8F-PoE+ (page 39).

9. Open a web browser and enter the IP address of 192.168.0.239 to display the login screen.

NETGEAR

Wiam LN aliows for advanced nefecrk configuraiion setup with addtional network
saTiching features

Rdain LI Login

10. Log in using the default credentials:

Username: admin
Password: (leave blank)

11. When prompted, change the default password. If successful, the Overview page will be displayed. Refer to the
illustration on the next page.

OmniStream Certified Switches 40




a PaNpuIT company

Default Configurations

NETGEAR =

Overview
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MA250-1DG2ZF-FoE+
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Porwer over Effusrmet . !
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HManisnance
AELeee Device Detalls
Daagnastics

12. Click Maintenance, in the left menu bar.

13. Click Browse File, under Restore, and select the configuration file to be uploaded.

Restore
The configuration will restore to the running-config and starup-config

Browse File
I M4250-40GEF-POE+ (GSM4248P).Clg |

14. Click the Upload button to upload the configuration file to the switch.

15. After the configuration file has been successfully uploaded, click the Restore Now button.

16. Configuration is complete.
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Netgear M4300-28G-PoE+

Configuration File https://atlonainc.box.com/s/tarn01a0jmkbvxIsl3njctho32cab2vo

Summary
Version: 12.0.7.17
Ports 1 through 24 can be used to connect OmniStream devices.

Ports 25 through 28 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:

VLAN1: http://192.168.1.254
VLAN 10: http://10.1.1.254
e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports: 25 through 28
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 24
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days *  Immediate leave: Enabled
e Spanning tree mode: RSTP *  Querier: Enabled
e BPDU guard: Enabled
e IGMP (VLAN 10 only)

*  Snooping: Enabled
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Netgear M4300-52G-PoE+

Configuration File https://atlonainc.box.com/s/ftjqi7cyhpOfxprecaxg6tvwgzn3plgs

IMPORTANT: The GSM4352PA model provides a 480 W PoE budget with a single power supply.
Depending on the number of connected PoE receivers, two power supplies may be required. Refer to
the following datasheet: https://www.downloads.netgear.com/files/GDC/datasheet/en/M4300.pdf

Summary
Version: 12.0.7.17
Ports 1 through 48 can be used to connect OmniStream devices.

Ports 49 through 52 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP address:
VLANT: http://192.168.1.254
VLAN 10: http://10.1.1.254

e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 49 through 52
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN 10
*  Ports: 1 through 48
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |GMP (VLAN 10 only)

e Spanning tree mode: RSTP * Snooping: Enabled

e BPDU guard: Enabled *  Immediate leave: Enabled
* Querier: Enabled
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Uploading configuration files to Netgear 4300 switches

1. Connect a computer directly to the switch using the out-of-band (OOB) interface.

2. In Windows, go to the command prompt, type ncpa.cpl, and press [ENTER]. This will display the network
properties for Windows.

3. Right-click on the adapter for the network switch and select Properties from the context menu.

4. Under the Ethernet Properties dialog box, click Internet Protocol Version 4 and then click the Properties
button.

5. Click the Use the following IP address radio button and enter an IP range between 192.168.0.1 through
192.168.0.254.

6. Set the Subnet mask field to 255.255.255.0.

7. Click the OK button, then minimize the Network Connections window. This window will be used again, later in
the procedure.

8. Download the configuration file from the link at the top of the page under Netgear M4300-28G-PoE+ (page 42)
or Netgear M4300-52G-PoE+ (page 43).

NETGEAR — S -

M4300-28G-PoE+ ProSAFE 24-port 1G PoE+ and 2-port 10GBASE-T and 2-port 10G SFP+

Login ()

Usermname* || ]

Password

9. Open a web browser and enter the IP address of 192.168.0.239 to display the login screen.

10. Log in using the default credentials:
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Username: admin

NETGEAR — S -

M4300-28G-PoE+ ProSAFE 24-port 1G PoE+ and 2-port 10GBASE-T and 2-port 10G SFP+ Welcome admin | 1| £

[ _sysem | swicnng | Rowng _|_qos | seaurty | _montomng _| |_vep | imaex |

Device View  Services Stacking PoE SNMP  LLDP  Link Dependency ner Schedule

[ v | oo |

Managemer System Configuration z
- Initial Setup Admin Password

+ System Information Enable Password

-System CPU Status v System Name

- Switch Statistics System Location
+ USB Device Information System Contact
« Slot Information SNTP Mode © Disable @ Enable
+ Loopback Interface SNTP Server time-a.nelgear.com
- Management Interfaces v Designated Source Interface Management VLAN v
« Time v
*DNS v
IPv4 Management VLAN Configuration ®
- SDM Template
Preference Management VLAN ID 1
« Green Ethemet
Routing Mode @ Enable O Disable
« Bonjour
IPv4 Address Assignment @ DHCP
© Static IP Address Subnet Mask Gateway
IPv6 Management VLAN Configuration ®
Management VLAN ID o
IPv6 Address Assignment © DHCPv6
@ Auto Config
© Static IPV6 Prefix/Length Gateway
Password: (leave blank)
11. Click the Maintenance tab, at the top of the screen, then click the Upgrade tab.
NETGEAR — " -
M4300-28G-PoE+ ProSAFE 24-port 1G PoE+ and 2-port 10GBASE-T and 2-port 10G SFP+ Welcome admin | || £
| System | switching | Rouing | QoS | Sceuty | Montoing | Mantenance | bep [ mbex [ |

Save Config Reset Export Image Management ~ Troubleshooting
[ o |

+ File Upgrade File Type
- USB File Upgrade Select File

SSL Trusted Root Certificate PEM File

SSL Server Certificate PEM File
SSL DH Weak Encryption Parameter PEM File
SSL DH Strang Encryption Parameter PEM File

Factory Default Configuration
Public Key Configuration
Public Key Image
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12. Click HTTP File Upgrade in the menu bar on the left side of the screen.

[ NeTeEar TN
M4300-28G-PoE+ ProSAFE 24-port 1G PoE+ and 2-port 10GBASE-T and 2-port 10G SFP+ Welcome admin | k| 4
I I e e S
HTTP File Upgrade ®
+ File Upgrade File Type Text Configuration v

. HTTP File Upgrade Select File w No file selected

+USB File Upgrade

©2018 NETGEAR, Inc. Al rights reserved

18. Click the File Type drop-down list and select Text Configuration.

Alert

You will be redirected to the login page now.

14. Click the Browse... button and select the configuration file to be uploaded.

15. After the configuration file has been successfully uploaded, a message box will be displayed indicating that the
web interface redirect to the login page. Click OK to dismiss the message box.

16. Maximize the Network Connections window from Step 7, and click the Obtain an IP address automatically
radio button, then click OK to apply changes.

17. Configuration is complete.
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Pakedge S3L-24P

Configuration File https://atlonainc.app.box.com/s/atpqziv3rbtf82ps7kgvoub6c66mk5p2

Summary
Version: 1.0.0
Ports 1 through 23 are to be used only for OmniStream.

Ports 24 through 28 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

e Login credentials

*  Username: admin
*  Password: Atlona
e VLAN 1
*  Ports: 24 through 28
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 23
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days
e Spanning tree mode: Point-to-Point
e BPDU guard: Enabled
e [GMP (VLAN 10 only)
* Snooping: Enabled
*  Immediate leave: Enabled
* Querier: Enabled
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Uploading configuration files to the Pakedge S3L-24P switch

1. Download the Pakedge S3L-24P configuration file from the link under Pakedge S3L-24P (page 47).
2. Open a web browser and enter the IP address of the switch in the address bar.

3. Enter the login credentials. The following are the default login credentials:

Username:
Password:

pakedge
pakedges

4. Click Maintenance > Configuration at the top of the page.

» S3L-24pP
SYSTEM DASHBOARD

DASHBOARD  MAINTENANCE ~ ADMINISTRATION  CONFIGURE MONITOR  DIAGNOSTICS USERINFO LOGOUT

TR

Device Information

Product Description
Boot Loader Version
Firmware Version
Hardware Version
Serial Number

MAC Address

Layer 3 Lite Managed Switch
1.00.007

1.00

Al

S3L-24PT0816A00186
90-a7-c1-65-eb-20

System Name

System Location
System Time
System Up Time

Login Timeout (seconds)

S3L-24P

1970-1-1 00:20:50
0 days, 00:20:51
1200

Device Health

100%
0% 55ec21%

B0 1 Min27%

70% d

60%| M 5 Min:18% KB

50% 28:

0% ke
30%

20%
10% '

60(s) 50(s) 400 30() 206 106) 46.01% 77.03% Normal Normal 30°C

4. Select HTTP Restore from the Configuration drop-down list.

5. Click Choose File and select the Pakedge S3L-24P.conf file.

DASHBOARD  MAINTENANCE  ADMINISTRATION ~ CONFIGURE MONITOR  DIAGNOSTICS USERINFO LOGOUT

» S3L-24P
CONFIGURATION

Configuration
HTTP Restore ¥

running-config @ startup-config ~ Restore configuration from file:| Choose File | Pakedge S3L-24P.conf

6. Click the Restore button, on the right.

7. Configuration is complete.
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Ruckus ICX 7150-48ZP

Configuration File

https://atlonainc.box.com/s/cpzy20gmnfdbf8sg3gga?27hgkcaéddvx

Summary

Version: 08.0.70d

Ports 1 through 48 are to be used only for OmniStream.

Configuration Details

e Hostname:

* Login credentials

*  Username:

*  Password:
e VLAN 1

*  Ports:

*

Static routing:

DemoSw

admin

Atlona

1 through 48
10.10.8.1

NOTE: Ruckus switches use two types of images: 1. Switch Image 2. Router Image.
This configuration is based on the Switch image. Before applying this configuration, make sure that

i

the switch is running the Switch image.

Assumptions: This configuration is a flat Layer 2 configuration. To route across multiple networks, a

router will be required. This configuration also assumes that there is an external DHCP server (home

router).

e VLAN 1

*  Ports:

*  DHCP range:
e DHCP lease time:
e Spanning tree mode:
e BPDU guard:
e Green Ethernet:
e Loop Protection:
e SSH:
e Telnet:
e [IGMP

*  Snooping:

*  Unregistered flooding:

*

Immediate leave:

*

Querier:
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o NOTE: By default, Ruckus switches do not have a static IP address, but can act as a DHCP client.

1. Download the Ruckus ICX 7150-48ZP configuration file here.
2. Open a console session to the switch.

3. Enter the en command at the command prompt.

ICE7150-48ZPF Switch>en

No password has been assigned yet...
ICR7150-48ZP Switchit

4. Press [ENTER] then type conf t at the command prompt.
ICK7158-4
1CX7150—4

5. Press [ENTER].

ZP Switchiiconf t
ZP Switch{config>#

6. Open the configuration file in a text editor and copy-and-paste the contents of the configuration file into the
console window.

Tera Term: Clipboard conﬁr@tion X

ver 08.0.70aT211!stack unit 1 module 1 oK
port inline power power-by-dass 3 stp-br
wer power-by-dass 3 stp-bpdu-guard!lint
er-by-dass 3 stp-bpdu-guardlinterface e
lass 3 stp-bpdu-guardlinterface ethernst
stp-bpdu-guardlinterface ethernet 1/1/3
u-guardlinterface ethernet 1/1/47 spann

Cancel

7. Type the wr mem command at the command prompt and press [ENTER].
DemoSwit -
DemoSwitur mem 1
There is no startup config file. unable to save legacy config

Flash Memory Write (8192 bytes per dot?

grite startup—config done.
o
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8. Configuration is complete.
To access the switch, use the IP address 10.10.8.254 and log in using the following credentials:

username: admin
password: Atlona
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Ubiquiti ES-24-500W / ES-24-250W

Configuration File https://atlonainc.box.com/s/xpcrghwco946b80Igbz9dafk8u07cjmp

It should be noted that the only difference between the ES-24-500W and ES-24-250W switch is the power
consumption. The configuration information for both switches is identical. Refer to Uploading configuration files to
Ubiquiti switches (page 54) for details on uploading the configuration file to the switch.

Summary
Version: 1.8.1
Ports 1 through 22 are to be used only for OmniStream.

Ports 23 through 26 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports: 23 through 26
*  Static routing: 192.168.1.1 (home router for Internet traffic)

A IMPORTANT: Ports 25 - 26, are SFP interfaces and intended for 1G transceivers.

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10

*  Ports: 1 through 22 *  DHCP range: 10.1.0.1 through
10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days e |[GMP (VLAN 10 only)

e Spanning tree mode: RSTP *  Snooping: Enabled

e BPDU guard: Enabled *  Immediate leave: Enabled
* Querier: Enabled
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Ubiquiti ES-48-500W / ES-48-750W

Configuration File https://atlonainc.box.com/s/xkzril8ihpeuf551124rc20a12ygiksl

It should be noted that the only difference between the ES-48-500W and ES-48-750W switch is the power
consumption. The configuration information for both switches is identical. Refer to Uploading configuration files to
Ubiquiti switches (page 54) for details on uploading the configuration file to the switch.

Summary
Version: 1.8.0
Ports 1 through 46 are to be used only for OmniStream.

Ports 47 through 52 are to be used for management and can be connected to another network, such as a router that
has Internet access.

Configuration Details

Once the configuration file has been uploaded, access the switch GUI using the following IP addresses:
VLANT: http://192.168.1.254
VLAN10: http://10.1.1.254.

e Hostname: DemoSw

* Login credentials

*  Username: admin
*  Password: Atlona
e VLAN1
*  Ports: 47 through 52
*  Static routing: 192.168.1.1 (home router for Internet traffic)

NOTE: DHCP is not enabled on VLAN 1. It is expected that these ports would be connected

to an external network with its own DHCP server, which must be using the 192.168.1.1 through
192.168.1.254 range to function properly with this configuration. If a different IP range is used, then
the switch configuration must be modified, accordingly.

e VLAN10
*  Ports: 1 through 46
*  DHCP range: 10.1.0.1 through 10.1.1.0

NOTE: Static address assignments may be made in the 10.1.1.1 through 10.1.1.253 range with a
subnet mask of 255.255.254.0.

e DHCP lease time: 7 days *  Immediate leave: Enabled
e Spanning tree mode: RSTP *  Querier: Enabled
e BPDU guard: Enabled
e IGMP (VLAN 10 only)

* Snooping: Enabled
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Uploading configuration files to Ubiquiti switches

1.

9.

In Windows, go to the command prompt, type ncpa.cpl, and press [ENTER]. This will display the network
properties for Windows.

Right-click on the adapter for the network switch and select Properties from the context menu.

Under the Ethernet Properties dialog box, click Internet Protocol Version 4 and then click the Properties
button.

Click the Use the following IP address radio button and enter an IP address that is within the range of the
network switch. For example, if the switch is 192.168.1.2, then enter an IP address of 192.168.1.10.

Set the Subnet mask field to 255.255.255.0.

Click the OK button, then minimize the Network Connections window. This window will be used again, later in
the procedure.

Download the correct configuration file from the link at the top of the previous Ubiquiti configuration pages.

Power on the switch. Once the switch is powered, it will attempt to locate a DHCP server to assign an
IP address. However, by default, if no DHCP server is found, it will be assigned the static IP address of
192.168.1.2.

Open a web browser and enter the IP address of the switch in the address bar and display the login screen.

10. Click the Go to the legacy interface link, under the SIGN IN button.

IMPORTANT: Do not enter login credentials on this screen. Switch to the legacy interface before
entering login credentials.

EdgeSwitch

Click here

SIGNIN

By signingin to this device, you agree to be bound by the
terms and conditions of our :
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11. Enter the login credentials to access the user interface.

FolgeMAX"

Please Login

User Name

| Password

12. Enter the IP address of the switch in a web browser, login, and click System > Utilities > Transfer.

FooeMAX® - -+ - - - T T e e

Basic > Dashboard System Switching ~  Routing v  Secunty v QoS v

Dashboard Port Summary viAN Port Channel (LAG) PoE Configurati Port Mirroring Firmware Upgrade UNMS Restart Switch

EdgeSwitch . [ e < rwouer]

System Information Restart Switch

System Description P.0000000
i i Ping Fimare

system Location Logs

System Contact Management Access

1P Address Ping IPvE

Burned In MAC Address Port
LT TraceRoute

Statisics

Status

Device Information

TraceRoute IPvG
Machine Type Restart Switch

Machine Model . Ping
e[ IP* Address Conflict Ping e

Software Version
™ 1Pve

£

Transfer 1P Adess Gnfit
System Resource Usage .
Temperature Status — k. o

R ‘

UNMS Status

e

Logged In Users

13. In the Transfer tab, click the Upload button in the HTTP row, highlighted below. Once this button is clicked,
the HTTP File Upload dialog will be displayed.

Restart Switch Ping Ping IPV6 TraceRoute TraceRoute IPV6 1P Address Conflict Transfer Core Dump Core Dump Test U ) load button

File Transfer

Transfer Protocol Upload Download

TragsféF afile to the device Transfer afile from the device
HTTP m
TFTP s

TP

=
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14. Click the File Type drop-down list and select Setup Configuration.

FrineA Y =t et # NewUl [ SaveConfiguration  Log Out

Restart Switch Ping Ping IPV6 TraceRoute TraceRoute IPV6 IP Address Conflict Transfer Core Dump Core Dump Test

File Transfer

Transfer Protocol Upload Download
Transfer a file to the device Transfer a file from the device

HTTP ‘j‘ ‘Tl

HTTP File Upioad - ‘

File Type Startup Configuration v + ‘

Select File Choose File | No file chosen

Status

Progress

Startup Configuration k L

Choose File | Mo file chogsen

15. Click the Choose File button to display the
Open File dialog box. Select the configuration py :
file that was downloaded in step 7. fglcoinleansics

16. Click the Open button to select the
configuration file.

17. Click the Begin Transfer button on the HTTP File Upload dialog. The upload sequence should only take a few
seconds.

18. Click Close to dismiss the HTTP File Upload dialog box.
19. Click System > Utilities > Restart Switch.

20. Click the Restart Without Core Dump button.

FooeMAX" - - # NewUl @ SaveConfiguration  Log Out

System > Utilities - Restart Switch Basic v System ~ Switching ~ Routing ~ Security ¥ Qos

[IESUSWN  ping | PingIPv6 | TraceRoute | TraceRouteIPv6 | IP AddressConflict | Transfer | Core Dump | Core Dump Test
Restart Switch

Reload In Hours | 0 Minutes (0 days 00:01 to 6 days 23:59)

[@ Restarting the switch will cause all device operations to stop. This Web session will be disconnected and you will have to log in again after the device has been restarted_ All unsaved changes will be lost. Itis possible that the IP address of the switch will change. If this occurs you will need o
determine the new IP address 1o access the device using the Web.

| Refresn submit | | Restart With Core Dump Restart Without Core Dump |

Submit | Restart With Core Dump | Restart Without Core Dump
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21. In Windows, return to the Network Connections window, which was minimized in step 9. If the window was
closed, go to the command prompt, type cpna.cpl, and press [ENTER)] to restore the window.

22. Right-click on the adapter for the network switch and select Properties from the context menu.

23. Under the Ethernet Properties dialog box, click Internet Protocol Version 4 and then click the Properties
button.

24. Restore DHCP by clicking the Obtain an IP address automatically radio button.

25. Click OK to commit changes, then click OK on the Ethernet Properties dialog to dismiss it.

26. Go to the windows command prompt and check the IP of the network switch by executing the ipconfig
command. Note that it may take a minute or so for the switch to complete the reboot procedure. Once the
switch is up and running, the DHCP IP address will be displayed.

& Select Command Prompt

Rename this connection View status of this co

ix

Ethemnet 3
Subn R S "4 '
Default Gatewa e« = s e = s e .

i

27. Enter the new IP address of the switch in a web browser window. In the example above, the IP address is
10.1.0.5.

28. Configuration is complete. Log in to the switch using the following credentials:

Username: admin
Password: Atlona
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Before working with the OmniStream devices, the network switch must be set up. This section will provide
instructions for manually configuring two different switches: Araknis AN-310-SW-24-POE and Cisco SG350X-24MP.

Araknis AN-310-SW-24-POE

the following instructions are applicable to all Araknis 8/16/24-port network switches with both front

o NOTE: Although this section specifically shows images of the AN-310-SW-24-POE web interface,
and rear-facing ports. These switches default to an IP address of 192.168.20.254.

1. Connect the PC directly to any of the switch interfaces and configure the PC network adapter with a static IP
address within the same subnet. For example, if the default IP address of the switch is 192.168.20.254, then
assign the PC a static IP address in the range of 192.168.20.x (where x = 254).

2. Launch the desired web browser and enter the IP address of the network switch into the address field, then
press [ENTER].

3. Enter the username and password. The default login credentials are as follows:

Username: araknis
Password: araknis

araknis

4. The System Status page will be displayed.

araknis & CLOUD SERVICE: No Connection ) System Time: 2001-01-00 16:52:45 ) System Uptime: 8d 215314
SYSTEM STATUS
RSISIEM System Information
PORTS
System Name DemoSw
(@ seTTINGS
SYSTEM Model Number AN-310-SW-16-POE
EOHLS FW Version v1.2.00 (2000-12-31 19:11:11)
POE
VLans Service Tag ST185001930A842G
LINK AGGREGATION MAC Address D4:6A'91:AT:87:AD
ACCESS MANAGEMENT
IP Address 10.1.1.254
@) MAINTENANCE
PING TEST Gateway 10.1.1.1
TRAGE ROUTE
FILE MANAGEMENT [ i e T |
RESTART DEVICE Down 100fdx 1Gfdx 100fdx 1Gfdx Disabled
PoE PoE
LoG ouT
€ ADVANCED 1
[=]
(=]

5. Click Settings > System in the menu bar on the left. In the System Name field, optionally change the default
hostname. Refer to the next page for illustration.

OmniStream Certified Switches 58




a PaNpuIT company

Network Switch Configuration

6.

7.

8.

10.

11.
12.

e
i - Hostname ! 2
C“’Okrns s : 8d 21:53:21
' SYSTEM SETTINGS
@ sTatUs
SYSTEM Sys(em
PORTS
System Name [ Demosw ] (char: 1~255)
» SYSTEM System Location [Default Location ] (char - 0~255)
PORTS " [ 1

Enter the new administrator user name and password in the Admin Username and New Admin Password
fields, respectively. When changing the password, confirm the new password in the Confirm New Admin
Password field.

,/d ra kﬂ IS & CLOUD SERVICE: No Connection (D System Time: 2001-01-09 16:52.53 @ System Uptime: & 215321
SYSTEM SETTINGS —J Username and Password fields

@ sTATUS

SYSTEM sys(em

PORTS

System Name [ Demosw / ] (char - 1~255)

» SYSTEM System Location [Defautt Location i | (char - 0~255)

PORTS Admin Username [acmin ) \char- 1~ 18)

POE

VLANS Current Admin Password = ) |crar: 4~32)

LINK AGGREGATION New Admin Password ( ] char- 4 ~32)

ACCESS T

Confirm New Admin Password | [ ) (char: 4~32)

@ MAINTENANCE

SN TEST Management VLAN ID [ 1 v]

TRACE ROUTE LED & 1Gbps PoE Disabled

FILE T

RESTART DEVICE

LOG OUT IP Address Settings IRV
€ ADVANCED Pud IPv6

i i

Click Settings > Access Management in the menu on the left side of the screen.

Click toggle switch, next to IP Address Settings, and set it to IPv4.

araknis & CLOUD SERVICE: No Comnection  ( System Time: 2001-01-09 165253 () System Uptime: 8d 2153:21
- SYSTEM SETTINGS
@ sTatus
SYSTEM Srrm
PORTS
System Name [ Demosw ) (char - 1 ~255)
» SYSTEM System Location [Default Location ] (char: 0~255)
FERIS Admin Username [admln ] (char: 1~18)
POE
LTS Current Admin Password [""" O] (char - 4 ~32)
LINK AGGREGATION New Admin Password [ ) (char: 4~32)
ACCESS T
Confirm New Admin Password [ J (char - 4 ~32) H
@ VAINTENANCE IP Address Settings toggle
e g Management VLAN ID [ ]
TRACE ROUTE LED M PoE Disabled
FILE T
RESTART DEVICE
oG out IP Address Settings ~ [IFvA |
€ ADVANCED ‘ — ‘ - ‘
‘ Autn C; i ‘ & Stati DHCP ‘ 1Pyvf State ‘ ‘

Click the Static radio button, next to Auto Configuration.

Enter the following information in the IPv4 Address, Subnet Mask, and Default Gateway fields. This IP address
is used for management and the IGMP querier.

e |Pv4 Address: 10.1.1.254
e  Subnet Mask: 255.255.255.0
e Default Gateway: 10.1.1.1

Click Apply to commit changes. The switch will prompt to be set to the new IP address.

Update the network settings of the computer to use an IP address of 10.1.1.x (where x # 254) and a subnet of
255.255.255.0.
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18. Click Settings > VLAN, in the menu on the left side of the screen.
14. Change the name of VLAN 1. By default, all interfaces are part of VLAN 1. Create additional VLANs as required.
15. Click Advanced > Multicast > IGMP Snooping.
16. Click the following radio buttons, under IGMP Snooping.
e Status: Enabled

e Report Supression: Enabled
e Unregistered IPMC Forward Action: Drop

Settings
Status #Enabled  Disabled
Version wVZ  OVv3
Report Suppression +Enabled = Disabled
Unregistered IPMC Forward Action (Flood  ®Drop

17. Under VLAN Settings, click the IGMP Snooping Status drop-down list and select Enabled.

18. Click the Fast Leave drop-down list and select Enabled.

VLAN Settings
| WLAN ID | IGMP Snooping Status Fast Leave
1 [ Enabiad . Eralibisd

19. Under Querier Settings, click the Querier State drop-down list and select Enabled for VLAN1, then click Apply
to commit changes.

20. Locate the Querier Settings section and confirm that for VLAN ID 1, the following is true:

e Querier Status: Querier
e Querier IP: |P address should match the IPv4 address of the switch.
Querier Settings
VLAN Queriar Cusrier
1] Querier State | Version Status Cuerier IF
1 [ Enabda 'r] [ v ' T 01,1 254

22. Click Advanced > STP > Global Settings.

23. Under Basic Settings, click the Priority drop-down list and select 4096.

‘He...,m, ‘wec) Priority drop-down list
PORT STATISTICS
RUNNING CONFIG
D DEIERESS Basic Setting
» MULTICAST
IGMP SNOOPING Bridge Address D4BA 91
MLD SNOOPING Priority 4096 v (@09sN)
4 STP
» GLOBAL SETTINGS plaxinoion] 20 (1-40)

24. Click Apply to commit changes.

25. Configuration is complete.
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Cisco SG350X-24MP

IMPORTANT: The following is divided into five sections. Each section must be followed in the order
listed below. Deviating from this order, or skipping steps within a section, may result in unpredictable
switch operation.

Getting Started

VLAN Setup

IPv4 Interface Setup
Setting IP Multicast
Setting up User Accounts

Getting Started

1. Connect a PC or laptop to the network switch. It is best to you whichever port will remain on VLAN1 of the switch
to avoid the PC losing connection when settings are changed on the switch.

2. Go into the computer settings and change the IP of the PC to be on the same range as the switch.

to 192.168.1.xx, where xx represents values from 1 to 253, as long as that IP address is not already

o NOTE: If the IP address of the network switch is 192.168.1.254, then the computer should be set
assigned on that network. The default IP address for all Cisco switches is 192.168.1.254/24.

3. Launch the desired web browser and enter the IP address of the network switch into the address field, then
press [ENTER].

alialn Switch
c15¢o Application
pascvors

‘Secure Browsing (HTTPS)

d.
are registered trademarks or trademarks of ¢ Systems, Inc. andior its affiliates in the

4. Enter the username and password. The default login credentials are as follows:

Username: cisco
Password: cisco
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5. Click the Login button.

The switch will most likely require a new password to be assigned, before going further. This step may vary
depending on the network switch. Enter the desired password, as required.

lc;' SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch:

Change Password

| Display Moce: [T [ Logout swA  Apout Help

Q

‘The minimum requirements are as follows:
« Cannot be the same as the user name.

«Minimum length is &

New Password Configuration
Qld Password:

New Password:

Confirm Password.

Password Strength Meter:

Password Strength Enforcement

Flease change your passwerd from the default settings for better protection of your network

- Cannot be the same as the current password.

« Minimum number of character classes is 3. Charac

sses are upper case, lower case,

numeric, and special characters,

.o

Disable

ety ]

6. Click the Apply button to commit changes.

7. The Getting Started page will

be displayed.

sl
cisco

Commasanes
seimpes

Configuration Wizards

» Slalus and Staistics
» Administration S Initial Setup
» Port Managsment

» Smarport

» VLAN Management
> Spanning Tree

> MAC Address Tables

Manage Stack

Change Device IP Address
Create VLAN

Configure Port Setings

» IP Configuration
+ Security

» Access Control
» Quality of Senvice

Device Status
System Summary
Port Statistics
RIMON Statistics
View Log

Other resources: Support | Forums

[J Do not show this page on starup

s, Inc. All Rights Reserve

OmniStream Certified Switches

SG350X-24MP 24-Port Gigét;it PoE Stackable Managed Switch

Change Management Applications and Senvices

cisco  switchde6345 Language: [EFTE [ Display hode: Logout SMA About Help

This page provides easy steps to configure your device

. Quick Access
Change Device Password
Upgrade Device Software
Backup Device Configuration
Create MAC-Based ACL
Create IP-Based ACL
Configure QoS
Configure SPAN
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VLAN Setup

8. Click the Display Mode drop-down list, near the upper-right hand corner of the screen, and select Advanced.

il e st ETE [ Dspiay Mode: Logout SNA About Help
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch " Basic T

Getiing Startes

CGonfiguration Wizards
This page provides easy steps to configure your device

» Slalus and Statistics
» Administration ~w Initial Setup | Quick Access

> Port Management Manage Stack Change Device Password
Ghange Management Applications and Senvices Upgrade Device Software
Change Device IP Address Backup Device Configuration
Create VLAN Create MAC-Based ACL
Configure Port Setings Create IP-Based ACL

Configure QoS
Device Status
> Access Control
» Quality of Service

System Summary

|| English ¥ Display Mode: EEELIEY locout SNA  About Hel
oo I <
Cadvanced >

©2011-2018 Cisco Sys

9. Select VLAN Management from the menu on the left side of the screen. The VLAN Management menu will
expand and the VLAN Settings page will be displayed. If the VLAN Setting page is not displayed, click VLAN
Management > VLAN Setting to display the page.

By Default, VLAN 1 is active. If the network is self-contained, skip to 15. Otherwise, continue with the next step.

10. Click the Add... button. The Add VLAN dialog will be displayed. The purpose of creating a VLAN is to separate
a network into separate logical areas / broadcast domains. In this case, the VLAN is created to isolate AV-over-
IP traffic from normal network traffic.

alialn - = cisco  switchde6945  Language: Dispiay Mode: Logout SNA About Help
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I

S P VLAN Settings

C ‘Wizards VLAN Table

Search [] WLANID  VLANName Originators = VLAN Interface State Link Status
» Status and Statistics SNMP Traps

> Default Enabled Enabled
» Port lanagement

Delete
» Smariport [ Add VLAN - Google Chreme

_ ® Not secure | 192.168.0.117/csd8f3a7fd/Vmember/bridg_vian_properties a.htm
VLAN Seffings
Interface Settings
Portio VLAN ® VLAN
PortVLAN Membership # VLAN D! (Range: 2 - 4094)
» VLAN Translation
Private VAN Settings VLAN Name (0/32 characters used)
GVRP Setlings
» VLAN Groups
» Voice VLAN Link Stalus SNMP Traps: ¥ Enable

VLAN Interface State i Enable
> Access Port Multicast TV VLAR

» Customer Pert Wulticast TV
» Spanning Tree 5 VLAN Range: | - (Range: 2 - 4094)

i e ]

Range

> WAC Address Tables

» IP Configuration
» Security

» Access Control

+ Qualiy of Senice
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11. Enter the numerical ID of the VLAN in the VLAN ID field. This value is required and must be within the range of 2
to 4094.

o NOTE: VLAN 1 is the Cisco default VLAN. This VLAN can be used, but it cannot be modified or
deleted.

12. OPTIONAL: Enter a name for the VLAN in the VLAN Name field. For example, the name of the VLAN could
be used to identify a department, within a company, which uses that broadcast domain. In this example,
“OmniStream” has been assigned as the name of VLAN 5.

[ Add VLAN - Geegle Chrome - O ®
A Mot secure | 192.168.0.117 /csdEf3a7fd/Vmember/bridg_vlan_properties_a.htm

= VLAM
# VLAN ID: 5 | (Range: 2 - 4094)
VLAM Mame: |C}mni5tream | (1032 characters used)

VLAM Interface State: |« Enable
Link Status SNMP Traps: |« Enable
I Range

# VLAN Range: | - (Range: 2 - 4094)

(o [ Gose |

13. Click the Apply button to commit changes. If the VLAN was successfully created, the dialog box will display a
“Success” message.

v Success. To permanently save the configuration, go to the Copy/Save Configuration page or
click the Save icon.

® VLAN
£ VLANM 1D | | (Range: 2 - 4094)
VLAN Mame: | | (0432 characters used)

VLAN Interface State: |« Enable
Link Status SNMP Traps: |« Enable
I Range

# VLAN Range: | - (Range: 2 - 4094)

(o] [ ciose |
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14. Repeat steps 11 through 13 to create as many VLANs as needed. If no additional VLANs are required, click the
Close button to dismiss the Add VLAN dialog box.

15. Click Administration, in the left-hand menu bar and select File Operations. The File Operations page will be

displayed.

16. Click the Duplicate radio button, next to Operation Type.

cisco switchdessss  Language: [ENE]

[ Dicplay oce: [UNIITTIRG losout SNA About Help

cisco SG350X-24M 24-Port Gigat;i-tiPoE Stackable Managed Switch

Discovery - Bonjour
> Discovery - LLDP.
+ Discovery - GDP
Locate Device.
Ping
Traceroute
» Port anagement
» Smartport
» VLAN Management
» Spanning Tree
» WAC Address Tables
v Wulticast
Properties
MAC Group Address
1P Hulticast Group Address
~ IPv4 Multicast Configuratio
IGHMP Snooping
IGHP Interface Settings
IGHMP VLAN Seftings
IGHMP Proxy
+ IPY6 Mutticast Configuratio
IGHPIMLD Snooping IP Mu
Multicast Router Port
Forward All
Unregistered Multicast

+ IP Configuration -

| File Operations

Operation Type: ) Update File
©) Backup File

@® Duplicate
Destination File Type: & Running Configuration

O Language File

Copy Method: @ HTTPHTTPS
O usB
O Internal Flash
O TP

© SCP (File ransfer via

& ERIENE Browse... | Nofile select

fesomn[_comn |

COperation Type:

Destination File Type:

O@® ®00

D

pdate File
Backup File
Duplicate

Running Configuration
Startup Configuration
Mirrar Configuration

g File
Lsmansas Ll

17. Click the Apply button to commit changes.

cisco’ SG350X-24M 24-Port Gigaﬁ{t_PoE Stackable Managed Switch

Geting Started
Dashboard
Configuration Wizards

| File Operations

Success.

cisco  switchde6945 Language: ST [ Display hode: Logout SNA Aboul Help

aQ

» Status and Statist

System Settings
Console Setings
Stack Management
User Accounts

Idle Session Timeout
Time Setings
System Log

Fil

Operation Type O Update File
O Backup File

@® Duplicate

Source File Name: @ Running Configuration
O Startup Configuration

O Mirror Configuration
Destination File Name: (| Running Confiouration
@ Stariup Configuration

Firmware Operations
File
File Directory
DHCP Auto Configuratior
PP
Rebaot
Hardware Resources
Discovery - Bonjour
» Discovery -LLDP
» Discovery - CDP
Locate Device
Ping
Traceroute
» Port Management
» Smartport

v VLA Management

Certified Switches

o[ cann |

his Reserved,

g Notification (Notice):
RAP:

ui
Iconfiguration/startup-config
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IPv4 Interface Setup

18. Click IP Configuration in the left-hand menu bar and select IPv4 Interface. The IPv4 Interface page will be

displayed.

cisco SG350X-24MP 24-Port GigaE& PoE Stackable Managed Switch

Getting Started
Dashboard

IPv4 Interface

cisco  switchde6%5 Language: [N [ Display Mode: Logout SNA FindT About Help

Configuration Wizards

» Status and Statistics
>

| 1Pvd Routing Enable

o] caren |

» Port

IPv4 Interface Table

» Smartport

[  Interface  IP Address Type  IP Address

Mask Status

» VLAN Management

O van1 DHCP  0.0.0.0

255255255255 Notreceived

» Spanning Tree O VANt Default 1921681254 2552552550  Valid
» MAC Address Tables [ Edit Delete

~ IPv4 Management and Interfad
IPv4 Static Routes
IPv4 Forwarding Table
» Access List
ARP
ARP Proxy
UDP Relay/IP Helper
+ DHCP SnoopingiRelay
» DHCP Senver
» IPv6 Management and Interfa
» Palicy Based Routing

> Access Control
» Quality of Senice

ystems, Inc. All Rights Reserved.

19. Click the check box next to VLAN 1 (DHCP) and then click the Delete button.

x| Save cisco  switchde6%45  Language: [T [  Display Mode: Logout SNA FindT About Help

cisco SG350X-24MP 24-Port Giga-l;ﬁ PoE Stackable Managed Switch
Gefting Started
Dashboard
Configuration Wizards

IPv4 Interface

‘ IPv4 Routing. Enable

| |
:

+ Port 1Pva Interface Table

b Status and Statistics

» Smartpart [] Interface IP Address Type  IP Address Vask Status
> VLAN
+ Spanning Tree O viant Default 1921681254 2552552550  Valid

» WAC Address Tables

Delete

Add. Edit

+ IPv4 Management and Interfag
IPv4 Static Routes

IPv4 Forwarding Table

» Access List

. IPv4 Interface

UDP Relay/IP Helper
» DHCP Snooping/Relay
» DHCP Server

» IPv6 Management and Interfad
» Policy Based Routing
+ DNS

» Security

» Access Control

» Quality of Senice

IPv4 Routing:

= [—hpﬂy—] [ Cancel ]

Inc. All Rights Reserved.

Enable

IPv4 Interface Table
IP Address Type

] Interface IP Address Mask Status

[] VLAN1

Default 192.168.1.254 2552552550 Valid

(I: Delete ])

Edit...
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20. Check the IP settings for VLAN 1. If no changes are required, continue with Step 4. However, if a different IP
address or subnet mask need to be specified, then follow the steps below:

a. Click the check box next to VLAN 1.

b. Click the Edit button.

feco  switchdeasts Langusge: [T B ospiey oce Logost SNA FnaT Aot Help

ehst’ SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch [

Getting Started

IPv#4 Interface

Success. To permanently save the configuration, go to the Fil= Operations page or click the Save icon

| IPv4 Routing: Enable

[apply| [ cancel

IPv4 Interface Table

> Smariport

Interface | IP Address Type | IP Address

v IPvd Management and Interfad
1Pv4 Static Routes
IPv4 Forwarding Table
» Access List
ARP
ARP Proxy X
Uoe e lr IPvd Routing: Enable
» DHCP Snooping/Relay
» DHCP Server
» IPv6 Management and Interfaq
» Policy Based Routing

EEEEE [—iﬂﬁ—” Cancel ]

IPv4 Interface Table
Interface  IP Address Type @ |IP Address Mask Status

©2011-2018 Cisco Systems, Inc. All Rights Resenved

c. The Edit IP Interface dialog will be displayed.
d. Make make the required changes, then click the Apply button to commit changes.

e. Click the Close button to dismiss the Edit IP Interface dialog box.

Y Edit IP Interface - Mogzilla Firefox

GJ 192.168.1.254//cs7d5elf3e/mts/ipaddr/system_ipcont_ipinterface_e_jg.htm s (V) 'i'.'.? é}

Interface: I WLAM 1 | s

IP Address Type: () Dynamic P Address
(@ StaticIP Address

IP Addreszs: 192.168.1.254
& Mask: @ Network Mask [255.255.255.0
O PrefixLength | Range: & - 30
Renew [P Address MNow: Enable
Auto Configuration via DHCP: Disabled

[hpplyof [ Close |
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21. Click the Add... button. The Add IP Interface dialog box will be displayed.

22. Click the VLAN radio button, then click the drop-down list to select the VLAN that was created under VLAN
Setup (page 63).

23. Click the Static IP Address radio button.

o NOTE: It is recommended that a static IP address be assigned to a VLAN, to avoid IP changes.

24. Enter the IP address of the VLAN, in the IP Address field. In the example below, 10.1.1.254 is used. However,
any available IP address in the pool may be used.

25. Click the Network Mask radio button and enter the subnet mask. In this example, 255.255.254.0 is used.
However, depending upon the requirements, any valid network mask may be used.

TR - cisco  Switchde6945  Language: Display Node: Logost SNA FndT Apout Help
alialn
cisco  SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I
Getling Started
IPv4 Interface
Dashboard
s guoliopilizagic ‘ 1Pv4 Routing Enable ‘
Search
» Stalus and Stalistics [ ———
5
+ Port IPv4 Interface Table
» Smaripart [ Interface IP Address Type  IP Address Mask Status
» VLAN [] VLANA Static  192.168.1.254 2552552550 \Valid
» Spanning Tree Add.. Edit Delete
* WAG Address Tables ) Add IP Interface - Mozilla Firefox
> Mulicast %
C @ 192,168.1.254/cs7d5e0f3e/mis/ipaddr/system_ipeont ipinterface_a_jg.htm -y =
~ IPv4 Management and Interfa
z
Inter unit [7777 port [2ET Lac 3 vLAn [515] O Leopback
= - nterface: O Uni 0 o ® O Leopbaci
IPv4 Forwarding Table IP Address Type: (O Dynamic IP Address
» Access List @ Static IP Address
ﬁ # |P Address: 10.1.1.254
UDP Relay/IP Helper & Mask @ Network Mask |§552552540
+ DHCP Snooping/Relay li nae 8- 3
Range: 8- 30;
. g © PrefixLength ang:

» IPv6 Management and Interfad

- P sasamog ] o

> DNs
> Security
» Access Control

— Interface: ) Unit |1— Port IT O LAG |1_ ® VLAN IE’ v O Loog

IP Address Type: () Dynamic P Address

- — (@) Static IP Address
2 |P Address: [10.1.1.254
# Mask: @ MNetwork Mask [255.256.254.0
i) Prefix Length | (Range: & - 30)

26. Click the Apply button to commit changes. Repeat Steps 4 through 9 for each additional VLAN, as necessary.
27. After all VLANs have been set up, click the Close button to dismiss the Add IP Interface dialog box.

28. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

29. Click the Duplicate radio button, next to Operation Type. Refer to the next page for more information.
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cisco  switchde6%45  Language: [T Display Mode: [FNNTIRIRY locout SNA About Help

SG350X-24MP 24-Port Gigat;i_t PoE Stackable Managed Switch

Discovery - Bonjour
> Discovery - LLDP.

+ IP Configuration

< >

30. Click the Ap

File Operations

+ Discovery- CDP
e [;y Operation Type: @ Update File
p"me evice. ©) Backup File
ng O Duplicate
Traceroute
s Portmanagement Destination File Type: & Running Configuration
TE———— O Startup Configuration
S0 s— Wirror Configuration
» VLAN Management Lo File
> SpanningTree O Language File
» WAC Address Tables Copy Method: @® HTTRHTTPS T
v Wulticast O usB -
Properties O Intemnal Flash
MAC Group Address Q TFTP
1P Multicast Group Addrese © SCP (File ransfer via SSH)
~ IPv4 Multicast Configuratio # File Name Browse_ | Nofile selected
IGHMP Snooping
IGHP Interface Settings
IR WAN Setings ¢ |- Aboly-—|
IGHMP Proxy
+ IPY6 Mutticast Configuratio
IGHPIMLD Snooping IP Mu
Multicast Router Port
Forward All
Unregistered Multicast

ply button to commit changes.

File Operations

Cperation Type:

Source File Name:

Destination File Mame:

((®) Duplicate

() Update File
() Backup File

(® Running Configuration
() Startup Configuration
() Mirror Configuration
Running Configuration
(® Startup Configuration

[—‘\HU—] [ Cancel

|

‘cisco SG350X-24MP 24-Port GigaBi:f PoE Stackable Managed Switch

Geting Started
Dashbeard
Configuration Wizards

» Status and Statist

File Operations

cisco  switchde6945  Languace: BRI [ Display Mode: Logout SNA About Hep

Q

System Settings
Console Setings
Stack Management
User Accounts

Idle Session Timeout
Time Setings
System Log

Fil

Operation Type: () Update File
O Backup File

@® Duplicate

Source FileName: (@& Running Configuration
O Startup Configuration

O Mirror Configuration
Destination File Name: | yning Confiouration
@ Startup Configuration

Firmware Operations

File Directory

DHCP Auto Configuratior

PNP
Rebaot
Hardware Resources
Discovery - Bonjour
Discovery - LLDP.
Discovery - CDP
Locate Device
Ping
Traceroute

» Port anagement

» Smartport

v VLA Management

= |
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Port Mapping

31. Click Port to VLAN from the VLAN Management menu. By default, the Membership Type, for each physical
port (interface), is assigned as Untagged.

thah cisco  switchde894s  Language: Il ~ [REETEEY Advanced ~ JENT
afraln

cisco SG350X-24MP 24-Port Gigabft _PoE Stackable Managed Switch

SNA  FindT About Help

a

——— *| Port to VLAN
Wizards L ip Table ‘Showing 1-28 0128 | Al v per page
Fiter VLANID equalsto [ 1]~
AND Interface Type equals to | Port of Unit 1 |~
Interface Name | VLAN Mode | Membership Type | PVID
GE1 Access Untagges  |v
GE2 Access [Untagged v |
cE3 Access [Uniagged ||
"95 GE4 Access [Untagged  |v|
_me"mwsmp GES Access Untagged  |v
P - = Access Untagged  |v
Private VLAN Setings GE7 Access [Untagged |«
GVRP Seftings GEB Access [Untagged  |v|
: mm‘“ GE9 Access ‘Untagged v |
+ Antess PortMuticastTvyl B | GET0 Access Untagged  |v
» Customer Port Multicast T\ GEM Access Untagged |«
» Spanning Tree GE12 Access [Untagged |- |
» MAG Address Tables GE13 Access Untagged |v
GE14 Access [Untagged v |
o] | cEts Access [Untagged |+ |
Access [Uniagged |

32. Click the VLAN ID equals to drop-down list and select the VLAN ID that was created under VLAN Setup (page
63).

33. Leave the AND Interface Type equals to drop-down list as Port of Unit 1. Click the Go button.

NTRIT _ — cisco  switchde6945  Language: Display Mode: Logout SMA FindT About Help
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I <
Getiing Started ~ ~
e Port to VLAN
Dashboard
C Wizards VL lip Table Showing 1-28 of 28 Al .~ per page
S — Fiter VLAN ID equals to

» Status and Statistics

mSictusant Sicdiniion .
N AND fnrsriacsTypsln Port of Unit 1|

» Port Interface Name | VLAN MJ¥E®Hiembership Tipe | PVID
» Smartport GE1 Acoess Untagged |
v SEREREnAiemE = HEEEED |Untagged [
e E——— = Port to VLAN
Interface Settings GE4 Access [Untagged |+
GES Acc [lintanned o

VLAN Membership Table

Filter VLAN /D equals to

AND Interface Type_L__to [PortafUnit1 /v | Go |
Interface Mame = VLAM M embership Type @ PVID
GE1 Access | Untagged |«
GE2 Access | Untagged |«
GE3 Access | Untagged |«
Access | Untagged |«
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34. The Membership Type, for the VLAN, will automatically be assigned as Excluded for each physical port on the
switch.

cisco  switchde6945  Language: [ERela] [ Display ode: XSSl Looout SNA FindT  About Help

I

cisco SG350X-24MP 24-Port GigaBﬁ PoE Stackable Managed Switch

Getting Started A Port to VLAN

Dashboard
c Wizards v ip Table Showing 1-28 of 28 | All |~ | per page
iaary Filler VLAN D equalsto | 5[]

> Stalus and Stalistics

N AND Interface Type equals to | Port of Unit 1 |v|

» Port Interface Name | VLAN hode | Membership Type | PVID

» Smarport GE1 Access Excuded |

GE2 Access |Excluded ||

VLAN Settings CE3 Access [Excluded ||
e SELe GE4 Access [Excuded v
PortVLAN Wembership 58 eSS [Exciuced ]

o T T T GES Access Excuded |-
Private VLAN Settings GET Access Excuded |
GURP Seftings GEB Access |Excluded ||

b TAGIERTD GEY Access Excluded |-
» Voice VLAN =
) el EOR—— GE10 Access Excuded
+ Customer Port MuticastTh ., | | GE11 Access Excuded v
Access Excuded v

stems, Inc. All Rights Reserved

35. Determine which physical ports will use the selected VLAN. Click the Membership Type drop-down list for each
physical port that will use the VLAN, and set its value to Untagged. For example, if physical ports 6 and 7 will be
used for VLAN 5, then set the Membership Type for these two ports to Untagged.

Port to VLAN

VLAN Membership Table

Filter VLAN /D equals to IE o

AMD Interface Type equals to |F'nrt af Lnit 1 |~ Go

Interface Mame = VLAMN Mode  Membership Type | PVID
GE1 Access | Excluded
GE2 Access
GE3 Access
GE4 Access Mulkicast TV VLAN
GES Access | Excluded v

36. Scroll to the bottom of the list of ports and click the Apply button. Success messages will appear at the top and
bottom right of the screen.

NOTE: If the port the PC is connect to is move off VLAN1, then it will need to be set to the IP settings of the
new VLAN to continue.

=
Ineriace Setings GE1 Access Excuded |
Portto VLAN GE2 Access Excuded |~
Port VLAN Membership GE3 Access Excluded |~
F Gkl e GE4 Access Untagged v
Private VLAN Setlings ——
e e GES Access Untagged v
» VLAN Groups GES Access Untagged -
» Voice VLAN GE7 Access Untagged |
F AEERRR P (Rt GES Aocess Untagged |
> oo &
Customer Port Multicast T\ oeo ccess T
b s T —
DM Syl GE10 Access Untagged |
» MAC Address Tables
GET1 Access Excuded |-
GET2 Access Excuded |~
~_IP Configuration
GE13 Access Excuded |
~ IPvd Managementand Inte e
A GE14 Access Excuded v
[Pvé StaticRoutes GE1S Access xcluded 1 Notification (Notice):
IPv4 Forwarding Table GE16 Access Excuded |- opy operation was
b el GETT Access Excluded |~
y GE18 A Excluded
i coess Jcluded |
UDP RelaylP Helper GE19 Access Untagged |~
» DHCP Snooping/Relay GE20 Access Excuded v
» DHCP Server cE24 Access Excuded |
» IPY6 Management and nte —_—
» PolicyBasedRoutng v | | °522 Access Excluded v Iconfiguration/startup-config
Access Excuded |~
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Configuring IP Multicast

37. Click Multicast from the menu bar on the left side of the screen. The Properties window will automatically be
displayed.

cisco  swilchde6945  Language: SN [ Oisplay Mode: NI  Logout

SNA  About Help

Q

cisco SG350X-24MP 24-Port Gigalii;f PoE Stackable Managed Switch

Discovery - Banjour " Properties
» Discovery-LLDP
» Di -coP
Li:‘:"‘gwce Bridge Multicast Filtering Status: [] Enable
Ping
Traceroute VLAN ID 1[v
» Port lanagement
Forwarding Method for Pvé: (& MAC Group Address
O IP Group Address
» VLAN Wanagement O Source SpecificIP Group Address
»_Spanning Tree Forwarding Method for IPvd: (@ MAC Group Address
» MAC Address Tables O IP Group Address
© Source SpecificIP Group Address
MAC Group Adsross I
IP Multicast Group Addres
< >

ns, Inc. All Rights Reserved

38. Click the Enable box, next to Bridge Multicast Filtering Status, to enable this feature.

39. Click the IP Group Address radio button, under both Forwarding Method for IPv6 and Forwarding Method for
IPv4.

Properties

Bridge Multicast Filtering Status: Enable

WLAM ID: I‘I e

Forwarding Method for IPvE: ) MA o Address
(@) |IP Group Address
() Source Specific IP Group Address

) MAC p Address
(@) |P Group Address
() Source Specific IP Group Address

Forwarding Method for 1Pv4:

[—m—] [ Cancel ]

40. Click the Apply button to commit changes.

41. Repeat steps 38 and 39 for each VLAN.

42. Click IGMP Snooping, under IPv4 Multicast Configuration, from the menu bar on the left side of the screen.

T T OTC T T g S T TS TIT T

S [—Am_][ Cancel ][ IGMP Snooping IP Multicast Group ]
F WLAM Management

¥ 3Spanning Tree IGMP Snooping Table
» MAC Address Tables Entry Mo. | VLAMID | IGMP Snooping Status MRouter Ports | Immediate | Last Membs
| O EEEESE Administrative | Operational Auto Learn Leave Cluery Counte
Properties l 1 1 Disabled Disabled Enabled  Disabled
MAC Group Address - - -
IP Multicast Group Address R RS B
* |Pvd Multicast Configuratio
v
< >
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43. Click the check box next to IGMP Snooping, to enable this feature.

44. Click the Apply button to commit changes.

IGMP Snooping

IGMP Snooping is only operational when Eridge Multicast Filiering is enabled. Bridge Multicast Filtering is currently enal

IGMP Snooping Status: Enable
IGMP Querier Status: Enable

Apply ][ Cancel ][IGMF’SnoopinglF’I'u'IuIticastGroup

45. Click the radio button next to VLAN 1, as shown below, in the IGMP Snooping Table.

cisco  switchde6345 Language: BN Display Mode: [ERNETISTIRG Logout

SNA  About Help

Q

cisco SG350X-24MP 24-Port Gigat;it PoE Stackable Managed Switch

Discovery - Bonjour “1 icmP Snooping
+ Discovery-LLDP
» Discovery - CDP =
Locate Device Success. To permanently save the configuration, go to the File Operations page or click the Save icon.
Ping
Traceroute IGNMP Snooping is only operational when Eridge Huliicas! Fillering is enabled. Bridge Multicast Filtering is currently enabled.
» Port
» Smartport IGMP Snooping Status: [] Enable
» VLAN Management IGMP Querier Status: Enable
» Spanning Tree
» MAC Address Tables |~~pply—|| cancel || IGHP Snooping IP Multicast Group
PropT IGHP Snooping Table
MAC Group Address: EntryNo. | VLANID | IGMP Snooping Status WRouter Ports | Immediate | LastMember IGMP Querier Status IGMP Querier | IGMP Querier | Querier
IP Multicast Group Address Operational Auto Lean Leave | Query Counter Operational | Election Version 1P Address
~ IPv4 Multicast Configuratio
e
IGMP Interface Setiings v Copy Settings. Edit.
< > —

46. Click the Edit... button to display the Edit IGMP Snooping Settings dialog box.

Y Edit IGMP Snooping Settings - Mozilla Firefox

@ 192.168.1.254/csafab2 1cd/multicast/igmp_snooping_e_jg.htm e I f? é}
VLAM ID: I'I w
IGMP Snooping Status: [J] Enanle

MRouter Ports Auto Learn: Enable

Immediate Leave: [] Enable
# Last Member Query Counter: @ Use Query Robustness (2)
() UserDefined | Range: 1-7

IGMP Querier Status: [] Enable

IGMP Qluerier Election: Enable

IGMP Querier Version: V2

Querier Source IP Address: Auto

User Defined

\hpply—|| Close
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47. Click the Enable checkboxes next to IGMP Snooping Status, Immediate Leave, and IGMP Querier Status.
Make sure each of these checkboxes display a checkmark. Leave the rest of the settings as they are.

48. Click the Apply button to commit changes.

Y Edit IGMP Snooping Settings - Mozilla Firefox

(0] 192.168.1.254 /csafab2 1cd/multicast/igmp_snooping_e_jq.htm e (W) T:f
VLAM 1D: |1 v
IGMF Snooping Status: Enable

MRouter Ports Auto Learn: Enable
Immediate Leave: Enable

# LastMember Query Counter: @) Use Query Robustness (2)

() User Defined | Range: 1-7
IGMP Querier Status: Enable
IGMP Querier Election: Enable
IGMP Querier \Version: @ v2

v3

Querier Source |P Address: @ Auto
() User Defined

192.168.1.254

tpplyf | Close |

49. Click the VLAN ID drop-down list, and select the next VLAN ID number. Repeat steps 17 and 18 for each VLAN
that was created.

50. Click the Close button to dismiss the Edit IGMP Snooping Settings dialog.

51. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

52. Click the Duplicate radio button, next to Operation Type, then click the Apply button to commit changes.

cisco  switchde6945  Language: [Eipee) [ oipiay ode: PRV locout SMA  About Help

"tistl’ SG350X-24MP 24-Port Gigabit PoE Stackable Manag

\ s Sae | Fie Operations File Operations
" E":;U:E:m?gp Operation Type: @ Update File
Backup File
::l:gelmlle 8 DuDthte . )
— Destination File Type: (@ Running Configuration DpEratIUrl TFDE: l:::l Upda‘te File
T () Startup Configuration )
—] el ") Backup File
» Spanning Tree. O Language File @ Duplicate
- ::E;‘:"“SS b Gopy Method: 8 DSWBPMWPS —
operties (O Intemal Flash . . ) i
e O e Source File Mame: (® Running Configuration
IP Wulticast Group Address () SCP (File transfer via SSH) -
« oy | Fitins e ET TR () Startup Configuration
e — oo i) Mirror Configuration
IGMP Proxy
i Destination File Name: Running Configuration
Multicast Router Port
B — (® Startup Configuration
~_IP Configuration o

c. All Rights Reseved

[—#ﬂ—] [ Zancel ]
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583. Click Unregistered Multicast from the Multicast menu on the left side of the screen. By default, all physical
ports will have port forwarding enabled, as shown below.

'::Illsléloh SG350X-24MP 24-Port Giga-t;ﬁ PoE Stackable Managed Switch

Getting Started

cisco  switchde8945  Language: [EIT [ Display Mode: Logout SNA About Help

Unregistered Multicast

Dashboard
Configuration Wizards

== Fiter: Interface Type squals to | Port of Unit 1|+

hmEininsyendyinkafion Port GE1 GE2 GE3 GE4 GES GE6 GE7 GES GE9 GE1D GETl GE12 GE13 GE14 GE15 GE16 GE17 GE1% GE19 GE20 GEZ1 GE22 GE23 GE24
5

Adminisiraion Fwating ® ® ® ® ® ® @ ® ® ® ® ® ® ® @ ® ® ® ® ® ® ® ® ®©
» PortHanagement s O O O O O O OO OO O OOOOOOOOoOOO OO 0 0 O
» Smariport

— Port X61 XG2 XG3 XG4

» Spanning Tree Fowardng. @ © ® @

» MAC Address Tables Fitlng. O O O O

Proparies (=—toptr—|[_Cancel |

MAG Group Address
1P Multicast Group Address
~ IPud Wulticast Configuration
IGMP Snooping
IGMP Interface Settings
IGMP VLAN Setiings
IGMP Proxy
» IPV6 Mutticast Configuration
IGMPIMLD Snaoping IP Multic]
Multicast Router Port
Forward All

54. Click the Filtering radio button to assign port filtering to each port.

55. Click the Apply button to commit changes.

Unregistered Multicast

Filter. Interface Type equals to IF'ortofUniH ~

Port GE1 GE2 GE3 GE4 GE5 GE6 GE7 GE8 GE9 GE10 GE11 GE12 GE13 GE14 GE15 GE16 GE17 GE18 GE19 GE20 GE21 GE22 GE23 GE24
Fowaring O O O O O O O ©O O O O O © O O ©C O ©C O O O O O O
Fiterlng ®© ®© ©® ®© ® ©®© ©® ® ©® ® ©® ® ® ©® ® ©@ ® ® ©@ ® ©®© ® ® @
Port XG1 XG2 XG3 XG4

Forwarding O O O O
Filtering (@ @ @ @

[—&pﬂy—] [ Cancel ]

56. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

57. Click the Duplicate radio button, next to Operation Type, then click the Apply button to commit changes.

cisco  switchde6345  Languace: ST [ Display Mode: Logout SNA About Hep

cisco SG350X-24MP 24-Port Giga-l;ijf PoE Stackable Managed Switch I

Getling Started
Dashboard

Configuration Wizards S
UCCEess.

°| File Operations

Operation Type O Update File
System Setiings O Backup File
Console Seffings @® Duplicate
Stack Management Source File Name: (@ Running Configuration
User Accounts O Startup Configuration
Idle Session Timeout O Miror Configuration
» Time Settings
» System Log
~ Fil
Firmware Operations
[
File Directory
'DHCP Auto Configuratior
» PNP
Reboot
Hardware Resources
Discovery - Bonjour
» Discovery - LLDOP
» Discovery - CDP
Locate Device
Ping
Traceroute
» Portlianagement Syslog Noti
%COPY--FILET
9-config destination
[+ VLA Wanagement Iconfiguration/starup-config
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Creating User Accounts

This next section is optional, and provides instructions on creating user accounts. This is only required if multiple
users will need access to the network switch.

1. Click User Accounts from the Administration menu.

cisco  switchde694!
wafn

cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch

Getting Started
User Accounts
Dashboard
Configuration Wizards ‘ Password Recovery Senvice: Enable
Search

» Status and Statistics I

i 1 Cancel ]
System Settings User Account Table
Console Settings UserMame = User Level
Stack Management O cisco Read/\Write Management Access (15)
User Accounts
Idle Session Timeout Ea Blelele

s Tima Qattinae

@ 2011-2018 Cisco Systems, Inc. All Rights Reserved.
2. Click the Add... button to display the Add User Account dialog box.

3. Enter the desired username and password in the User Name and Password fields, respectively. Confirm the
password by re-entering it in the Confirm Password field.

4. Click the Read/Write Management Access radio button, then click the Apply button to commit changes.
5. Repeat steps 2 through 4, as required, for each user.

6. Click the Close button to dismiss the Add User Account dialog box and click Yes when prompted to save
changes.

Y Add User Account - Mozilla Firefox

N1 192.168.1.254/cs7d5e0f3e/mts/password,/security_manage_localusers_a.htm e [ ﬂ’ é}

The minimum requirements for password are as follows:

+ Cannot be the same as the user name.

* Minimum length is 8.

* Minimum number of character classes is 3. Character classes are upper case, lower case,
numeric, and special characters.

New User
£ User Name: minion (6/20 characters used)
FPassword: (17/64 characters used)

Confirm Password:

Password Strength Meter: [ T Strono

User Level: Read-Only CLI Access (1)

R??W ;%1
& Read/\Write Management Access (15)

mpply|[_ Close |

OmniStream Certified Switches 76



a PaNpuIT company

Network Switch Configuration

Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

Click the Duplicate radio button, next to Operation Type.

Click the Apply button to commit changes.

. Switch configuration is complete.

x| Save

cisco  switchde6945  Language: [ST [ Disploy Node: Logout SMA About Help

cisco SG350X-24MP 24-Port Gigabit boE Stackable Managed Switch

Discovery - Bonjour
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" | File Operations

: Operation Type @ Updats File
:’dem“'ce O Backup File
" O Duplicate

Traceroute

Destination File Type: @ Running Configuration
O Startup Configuration

Mirr

+ Port anagement
+ Smartport

+ VLAN Management
» Spanning Tree

File Operations

b ricn gy Copy Method: @ HTTPHTTPS
~ Wuticast O uss T -
Properties 8 Internal Flash
MAC Group Address TFTP . ) .
P tcas Group Addrst O 80P (e anstera s5¥) Operation Type: Update File
= IPv4 Multicast Configuratio # File Name: Browse. | No file selected. =
IGHP Snooping . H
[l i =
IGMP VLAN Settings ﬁ Cancel

1GHP Proxy

> IPVE Multicast Configuratio.
IGMP/MLD Snooping IP Mu
Multicast Router Port
Forward All

Source File Mame: (® Running Configuration
() Startup Configuration

i Mirror Configuration

Unregistered Multicast
~ IP Configuration v
< >

Destination File Mame: Running Configuration

(® Startup Configuration

[—hﬂ—] [ Cancel ]
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Configuration Requirements for Cisco Catalyst 9300

IGMP Configuration
e 1p igmp snooping last-member-query-interval 100
e 1p igmp snooping querier

e 1ip igmp snooping vlan wvlan-id immediate-leave

IGMP Recommended Configuration

What is IGMP?

IGMP snooping is a mechanism to constrain multicast traffic to only the ports that have receivers attached. The
mechanism adds efficiency because it enables a Layer-2 switch to selectively send out multicast packets on only the
ports that need them. Without IGMP snooping, the switch floods the packets on every port. The switch “listens” for
the exchange of IGMP messages by the router and the end hosts. In this way, the switch builds an IGMP snooping
table that has a list of all the ports that have requested a particular multicast group.

Problems can arise if you have a mixture of ports snooping and not snooping.

When IGMP is disabled, multicast is broadcast out all switch ports. This solution works but is typically not desired
and loses the benefits of a multicast solution.

Step 1 - Enable Global IGMP Snooping

IGMP snooping should be enabled by default on Cisco I0OS-XE. The following command is only required if IGMP
shooping is disabled.

Switch#conf t

Enter configuration commands, one per line. End with CNTL/Z.
Switch (config) #ip igmp snooping

Switch (config) #°7Z

Switch#

$SYS-5-CONFIG I: Configured from console by console

Switch#

Step 2 - Set IGMP Querier

Most networks use a single IP subnet for each broadcast domain (or VLAN). IGMP dynamically assigns the IGMP
querier address to the Layer-3 interface IP address, by default. Static configuration of the IGMP querier is only
required when using multiple IP subnets for a single broadcast domain or when using a secondary IP addresses on a
Layer-3 VLAN interface. In this case, the static querier address configuration can designate which IP address to use
for that VLAN. Note that specifiying the VLAN is optional.

Switch#conf t

Enter configuration commands, one per line. End with CNTL/Z.

Switch (config) #ip igmp snooping [vlan vlan-id] querier address ip-address
Switch (config) #°72

Switchi#

$SYS-5-CONFIG I: Configured from console by console

Switch#

OmniStream Certified Switches



a PaNpuIT company

Network Switch Configuration

Step 3 - Enable IGMP Immediate Leave

The device uses IGMP snooping Immediate Leave to remove from the forwarding table an interface that sends a
leave message without the device sending group-specific queries to the interface. The VLAN interface is pruned from
the multicast tree for the multicast group specified in the original leave message. Immediate Leave ensures optimal
bandwidth management for all hosts on a switched network, even when multiple multicast groups are simultaneously
in use. Immediate Leave is only supported on IGMP version 2 hosts. IGMP version 2 is the default version for the
device.

port. If Immediate Leave is enabled on VLANs where more than one host is connected to a port,

o NOTE: Immediate Leave should be used only on VLANs where a single host is connected to each
some hosts may be dropped, inadvertently.

ﬂ IMPORTANT: Do not use immediate leave if you are connecting hubs or additional switch to connect
more than one device to a port.

Immediate leave is recommended for the best user experience. Best practice guidelines recommends each device
has a dedicated switchport and Immediate Leave is configured for each VLAN. Configure Immediate Leave for each
VLAN that will be streaming AV over IP.

Switch#conf t

Enter configuration commands, one per line. End with CNTL/Z.
Switch (config) #ip igmp snooping vlan vlan-id immediate-leave
Switch (config) #ip igmp snooping last-member-query-interval 100
Switch (config) #°72

Switch#

$SYS-5-CONFIG I: Configured from console by console

Switch#
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Appendix

Troubleshooting

S3L-24P Pakedge Switch Isn’t Passing Multicast

SKU: S3L-24P

Challenge: The loaded Atlona default configuration file for the S3L-24P Package switch does not pass
OmniStream multicast as expected.

Details: The switch is not accepting the VLAN 10 IP interface using the provided configuration. The IGMP
Snooping mechanism won’t work as expected without the VLAN 10 IP address. The VLAN 10
default IP address (in case you are loading the Atlona default configuration file) is 10.1.1.254 with
a subnet mask of 255.255.254.0. To complete the switch configuration and begin using
OmniStream, follow the procedure below:

1. Log in to the web Ul of the Pakedge switch.
2. Click Administration > Management > Network Interface > IPv4.
3. Enter the following information in each field, as shown:

¢ |Interface: vlan10

e ARP timeout: 14400

e Primary IP address: Static, 10.1.1.254/23

4. Click the Apply button to commit changes.

5. Click Maintenance > Save, then save the current configuration.
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